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Chapter 1: Computer and its components 

What is a Computer? 
A computer is a machine or device that performs processes, calculations and operations 

based on instructions provided by a software or hardware program. It is designed to execute 

applications and provides a variety of solutions by combining integrated hardware and software 

components. 
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Input Devices 
An input device is any hardware device that sends data to a computer, allowing you to 

interact with and control it. Example of an Input devices. 

 Keyboard 

 Mouse 

 Scanner 

 Microphone 

 Web Camera 

 

 

Output Devices 
An output device is any device used to send data from a computer to another device or 

user. Most computer data output that is meant for humans is in the form of audio or video. 

Examples include:  

 Monitors 

 Projectors 

 Speakers 

 Headphones  

 Printers. 

https://www.computerhope.com/jargon/h/hardware.htm
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Storage Devices 
A storage device is any computing hardware that is used for storing, porting and extracting 

data files and objects. It can hold and store information both temporarily and permanently, and 

can be internal or external to a computer, server or any similar computing device. Examples of 

storage devices include:  

 Hard disk  

 DVDs  

 CDs.  

 Pen Drive (Flash) 
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Computer Memory 
Computer memory is any physical device capable of storing information temporarily 

like RAM (random access memory), or permanently, like ROM (read-only memory).  

 RAM (Random Access Memory): RAM (random access memory) is a hardware device 

that allows information to be stored and retrieved on a computer. RAM is a volatile 

memory and requires power to keep the data accessible. If the computer is turned off, 

all data contained in RAM is lost. 

 

 

 

 ROM (Read Only Memory): ROM is a storage medium that is used with computers and 

other electronic devices. As the name indicates, data stored in ROM may only be read. It 

is either modified with extreme difficulty or not at all. A simple example of ROM is the 

cartridge used with video game consoles, which allows one system to run multiple 

games.  

 

 
 

https://www.computerhope.com/jargon/r/ram.htm
https://www.computerhope.com/jargon/r/rom.htm
https://www.computerhope.com/jargon/v/volamemo.htm
https://www.computerhope.com/jargon/v/volamemo.htm
https://www.computerhope.com/jargon/s/stordevi.htm
https://www.computerhope.com/jargon/r/read.htm
https://www.computerhope.com/jargon/c/console.htm
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A Processor 
A processor is an integrated electronic circuit that performs the calculations that run a 

computer. A processor performs arithmetical, logical, input/output (I/O) and other basic 

instructions that are passed from an operating system (OS). Most other processes are 

dependent on the operations of a processor. 
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Chapter 2: Working with Windows OS 

What is a Computer Mouse? 
A computer mouse is a handheld hardware input device that controls a cursor in 

a GUI and can move and select text, icons, files, and folders. 

 

 

How to Work with Mouse 

Step 1: Pick up your mouse and have a look at it. 

 

 

At the front (which points away from you), there are two buttons – left and right. You 

press or, more correctly, ‘click’ these to make things happen. 

https://www.computerhope.com/jargon/i/inputdev.htm
https://www.computerhope.com/jargon/m/mouspoin.htm
https://www.computerhope.com/jargon/g/gui.htm
https://www.computerhope.com/jargon/t/text.htm
https://www.computerhope.com/jargon/i/icon.htm
https://www.computerhope.com/jargon/f/file.htm
https://www.computerhope.com/jargon/f/folder.htm
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Most mice also have a wheel in between the buttons that you roll to move up and down 

the screen – technically called ‘scrolling’. 

Step 2: Learn to hold your mouse comfortably. It’s normally held between your thumb and little 

finger like this: 

 

Step 3: Have a click. Use your index finger to click the left button and your middle finger to click 

the right button: 

 

 

Step 4:  Try to double-click. This is done quite often on the left button. You have to click twice, 

as quickly as possible. The first click tells the computer that you are in a particular ‘window’, 

and the second click tells it that you’re selecting a button or link or whatever to do something in 

that window. If you click too slowly, the computer just thinks you’re telling it where you are 

again and again, so do click quickly. 
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Step 5: Now try a right-click. Just click the right button, paying no attention where the cursor is 

on the screen. A menu will appear, giving you options. Whenever you right-click, it opens a 

menu. If you move your cursor off the menu and left-click, the menu will close. 

 

 

Understanding the Window Environment 

User Account 

The User Accounts section of Control Panel allows you to control Windows user settings. 

User accounts determine who can and cannot access the system. User accounts are also used 

to determine what rights a user will have on the system. The User Accounts section of Control 

Panel has three options: Change your account picture, Add or remove user accounts, and 

Change your Windows password. 

To locate the User Accounts section on your Computer, follow the following steps 

below: 
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Step 1: 

 

 

Step 2: 

 

 

 

 

 

 

 

 

 

Click on the Windows 

logo 

Click on the Search Button 
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Step 3: 

 

 

 

Step 4: 

 

 

 

 

Type Control Panel inside the search box and click 

on the enter button on your keyboard 

Click on User Accounts and Family Safety 



23 
www.teampiccolo.com 

Step 5: 

 

 

Step 6: 

 

Click on User Accounts 

Click on Make changes to my account in PC settings to change 

your Account Picture and Account Password 
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Step 7: 

 

 

Date and Time 

The Date and Time option allows you to configure time and date information for your 

PC. The Date and Time section of Control Panel has four options: Set the time and date, Change 

the time zone, Add clocks for different time zones, Add the Clock gadget to the desktop. 

 

 

 

 

 

 

 

 

 

 

 

Click on Browse button to select an 

Image from your PC 

Click on Sign-in 

options to create 

or Change your 

password 
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How to locate the Date and Time option: 

Step 1: 

 

Step 2: 

 

 

 

 

 

 

Click here 

Click on Change date and time settings to 

edit your PC date and time 
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Step 3: 

 

 

Working with Files and Folders  

What are files and folders? 

A file is very much like a typed document that you might find on someone's desk or in a 

filing cabinet; it's an item that contains a collection of related information. On a computer, 

examples of files include text documents, spreadsheets, digital pictures, and even songs. Every 

picture you take with a digital camera, for example, is a separate file, and a music CD might 

contain a dozen individual song files. 

Your computer represents files with icons. By looking at a file's icon, you can tell at a 

glance what kind of file it is. Here are some common file icons: 

Click on the Change date and time 

button to edit your date and time 

settings on your PC 
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A folder is little more than a container in which you can store files. If you put thousands 

of paper files on someone's desk, it would be virtually impossible to find any particular one 

when you needed it. That's why people often store paper files in folders inside a filing cabinet. 

Arranging files into logical groups makes it easy to locate any particular file. Folders on your 

computer work exactly the same way. This is what a typical folder icon looks like: 

 

 

Viewing your files in a folder 

 When you open a folder and see your files, you might prefer larger (or smaller) icons, or 

an arrangement that lets you see different kinds of information about each file. To make these 

kinds of changes, follow the following steps below: 

 

 

 

 

 

 

 

 

Picture Text Document 
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Step 1: 

 

 

Step 2: Press the right-click button on your Mouse 
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Step 3: Move your Mouse Pointer on the ARROW sign under the View 

 

Step 4: Select any of the option of your choice (I will try the Extra Large Icons) 

 

 

Finding your files  

When you need to find a particular file, you'll often know that it's located somewhere in 

a common folder like Documents or Pictures. Unfortunately, actually locating the file you want 

might mean browsing through hundreds of files and subfolders— not an easy task. To save 

yourself time and effort, use the Search box to find your file. 
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Step 1: 

 

 

Step 2: I will try to search for “php” 

 

 

 

 

 

Type the Name of the 

file in the search box 
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Copying and moving files and folders  

Occasionally, you might want to change where files are stored on your computer. You 

might want to move files to a different folder, for example, or copy them to removable media 

(such as CDs or memory cards) to share with another person. 

Most people copy and move files using a method called drag and drop. Start by opening 

the folder that contains the file or folder you want to move. Then open the folder where you 

want to move it to. Position the folder windows on the desktop so you can see the contents of 

both of them. Next, drag the file or folder from the first folder to the second folder. That's all 

there is to it. 

 

Creating and deleting files  

The most common way to create new files is by using a program. For example, you can 

create a text document in a word processing program or a movie file in a video editing program. 

Some programs create a file when you open them.  

When you open Microsoft Word, for example, it starts with a blank page. This 

represents an empty (and unsaved) file. Start typing, and when you are ready to save your 

work, click File in the menu bar and then click Save As. In the dialog box that appears, type a file 

name that will help you find the file again in the future, and then click Save (We will learn about 

Microsoft Word in the next chapter).   

To delete a file, open the folder that contains the file and then select the file. Press 

DELETE and then, in the Delete File dialog box, click on Yes. When you delete a file, it's 

temporarily stored in the Recycle Bin. Think of the Recycle Bin as a safety folder that allows you 

to recover files or folders that you deleted accidentally.  
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Opening an existing file  

To open a file, double-click it. The file will open in the program that you used to create 

or edit it. If it's a text file, for example, it will open in your word-processing program. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Double Click on the file to open the file 
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CHAPTER 3: Application Software 
An application is any program, or group of programs, that is designed for the end user. 

Applications software (also called end-user programs) include such things as database 

programs, word processors, Web browsers, spreadsheets, etc.  

In this chapter we will be learning Microsoft Word, Microsoft PowerPoint, Microsoft 

Excel, Microsoft Access and lastly CorelDraw. 

 

Microsoft Word 
  Microsoft Word allows you to create and edit personal and business documents, such 

as letters, reports, invoices, emails and books. By default, documents saved in Word 2010 are 

saved with the .docx extension. Microsoft Word can be used for the following purposes − 

 To create business documents having various graphics including pictures, charts, and 

diagrams. 

 To store and reuse readymade content and formatted elements such as cover pages 

and sidebars. 

 To create letters and letterheads for personal and business purpose. 

 To design different documents such as resumes or invitation cards etc. 

 To create a range of correspondence from a simple office memo to legal copies and 

reference documents. 
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Getting Started with Microsoft word 

In this chapter, we will discuss how to get started with Microsoft Word. We will 

understand how to start a Microsoft Word application in simple steps. Assuming you have 

Microsoft Word installed in your PC, to start the Word application, follow these steps – 

 

Step 1: 

 
 

Step 2: 

 
 

 

Click on the windows key 

Click on the Search button 



36 
www.teampiccolo.com 

Step 3: 

 
 

NB: I have installed Microsoft word 2013 on my PC, the procedure will work on both later and 

earlier version of Microsoft Word. 

 

Step 4: We have successfully started our Microsoft Word  

 

 
 

 

Type in word to search for Microsoft Word 

and CLICK on the enter button on your 

keyboard 
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Exploring Window in Microsoft Word 

 

 

 

 

 

 

 
 

 

 

 

 

File Tab 

The File tab replaces the Office button from Word 2007. You can click it to check 

the backstage view. This is where you come when you need to open or save files, create new 

documents, print a document, and do other file-related operations. 

 

Quick Access Toolbar 

 This you will find just above the File tab. This is a convenient resting place for the most 

frequently used commands in Word. You can customize this toolbar based on your comfort. 

File Tab 

Ribbon 

Status Bar Document Area 

View Button 

Zoom Control 

Quick Access Toolbar 
Title Bar 
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Ribbon 

 
 

Ribbon contains commands organized in three components: 

 Tabs − these appear across the top of the Ribbon and contain groups of related 

commands. Home, Insert, Page Layout are examples of ribbon tabs. 

 Groups − they organize related commands; each group name appears below the group 

on the Ribbon. For example, group of commands related to fonts or group of 

commands related to alignment, etc. 

 Commands − Commands appear within each group as mentioned above. 

  

Title Bar 

This lies in the middle and at the top of the window. Title bar shows the program and 

document titles. 

Zoom Control 

 Zoom control lets you zoom in for a closer look at your text. The zoom control consists 

of a slider that you can slide left or right to zoom in or out; you can click the + buttons to 

increase or decrease the zoom factor. 

View Button 

 The group of five buttons located to the left of the Zoom control, near the bottom of 

the screen, lets you switch through the Word's various document views. 

 Print Layout view − this displays pages exactly as they will appear when printed. 

 Full Screen Reading view − this gives a full screen view of the document. 

 Web Layout view − this shows how a document appears when viewed by a Web 

browser, such as Internet Explorer. 

 Outline view − this lets you work with outlines established using Word’s standard 

heading styles. 
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 Draft view − this formats text as it appears on the printed page with a few exceptions. 

For example, headers and footers aren't shown. Most people prefer this mode. 

 

Document Area 

 This is the area where you type. The flashing vertical bar is called the insertion point and 

it represents the location where text will appear when you type. 

 

Status Bar 

 This displays the document information as well as the insertion point location. From left 

to right, this bar contains the total number of pages and words in the document, language, etc. 

You can configure the status bar by right-clicking anywhere on it and by selecting or 

deselecting options from the provided list. 

 

Opening and Creating a Document 

You can open an existing document save on your PC or on a USB drive connected to 

your computer. To open an existing file, follow the steps below: 

 

Step 1: 

 

 

 
 

 

 

 

 

 

 

 

Click on the File Bar 
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Step 2: 

 

 
 

Step 3: 

 

 
 

 

Click on Open 

Click on Computer to locate where you 

stored the file you want to use 
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Step 4: 

 
Step 5: We have successfully opened our document. 

 

 
 

  

Click on the Open button 
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To create a new document, follow the following steps below:  

Step 1: 

 

 

 
 

 

 

 

Step 2: 

 

 
 

 

 

 

 

 

Click on the File bar 

Click on New 
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Step 3: 

 

 
 

Step 4: You have successfully created a new document. 

 

 
 

 

Click on Blank document 
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Editing a Document 

 Document edition is quite useful but you have to be careful when editing documents, a 

little change might change the entire document.  

 Let open a document to edit. If you don’t know how to open a document, please refer 

back to the screenshots above. 
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Let us add a new paragraph in our existing document.  

 

 
 

For instance, you want to add a semi-colon (;) after “meaning” on the first line of the 

new paragraph, move your mouse cursor behind g and press the semi-colon (;) button on your 

keyboard. 

 

   
 

At the end of the full stop (.), Press the ENTER 

button to start a new paragraph 

New paragraph added 
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Delete Text 

We have learned about how to edit a document, let us learn how to delete from a 

document. You might type something you did not want to type or there is something extra 

which is not required in the document. 

 You can delete a text by using the backspace button on your keyboard or the delete 

button. You can hold down the shift button on your keyboard and use the arrow keys on your 

keyboard to select a particular section or paragraph you want to delete.  

Let’s delete the paragraph we added in the screenshot above. 

 

 
 

 
 

 

The paragraph we want to delete; PRESS the 

delete button on your keyboard 
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Spell Check in Word 

Microsoft Word provides a decent Spelling and Grammar Checker which enables you to 

search for and correct all spelling and grammar mistakes in your document. Word is intelligent 

enough to identify misspelled or misused, as well as grammar errors and underlines them as 

follows. 

 A red underline beneath spelling errors. 

 A green underline beneath grammar errors. 

 A blue line under correctly spelled but misused words. 

 
 

 

 

 

 

To correct these two errors in our document using the Spelling and Grammar checker, 

follow the follow steps below: 

 

Step 1: 

 

 

 
 

A Spelling error 

Misused word error 

Click on the REVIEW bar 
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Step 2: 

 

 

 
 

A Spelling and Grammar dialog box will appear and will display the wrong spellings or 

errors in grammar. You will also get suggestions to correct as shown below: 

 

Step 3: 

 

 
 

 

 

 

 

 

Click on Spelling & Grammar 

Suggestions 

Click on Change if you want to use the suggestion 

Click on Add if you 

want to store the 

word 
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Step 4: 

 
 

Formatting Text 

 Formatting text deals with how you want the appearance of your document such as the 

Font type and Size, Text Decoration, Text Color, etc. 

 

Font Type and Size 

  We will understand in brief the font buttons that we will further use in this tutorial. 

Following is a screenshot to show you a few font related buttons. 

 

 

 

 
 

 

Home Tab 

Font Type Button 

Font Size Button 
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If you want to change the Font Type or the Font Size of a particular section of your 

document, select that section and follow the steps below: 

Step 1: 

 
Step 2: 

 

 
 

Scroll down to select your desire Font Type and Double Click on it. 

 

 

 

 

Click on the Font Type Button 



51 
www.teampiccolo.com 

Step 3: 

 
 

To change the Font Size, select the section you want to change the font size and click on 

the Font Size Button.  

 

 

 

 

Click on the Font Button 
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Text Decoration 

When we use the term decorate, it means decorate by putting the text in italics, 

underlining the text or making it bold to look more fancy and much more. 

 

Making Text Bold 

We use bold text to give more emphasis on the sentence. It is very simple to change a 

selected portion of text into bold font by following two simple steps – 

Step 1 − Select the portion of text that the font of which needs to be made bold. You 

can use any of the text selection methods to select the portion of text. 

Step 2 − Click the Font Bold [ B ] button in the Home tab Font group, or simply use Ctrl + 

B keys to make the selected portion of text bold. 

Making Text Italic 

An italic text appears with a small inclination and we use the italicized text to 

differentiate it from other text. It is very simple to change the selected text into italic font by 

following two simple steps – 

Step 1 − Select the portion of text the font of which needs to be italicized. You can use 

any of the text selection methods to select the portion of text. 

Step 2 − Click the Font Italic [ I ] button in the Home tab Font group, or simply use 

the Ctrl + I keys to convert the portion of text in italic font. 

 
 

 

Font Italic Button 

Font Bold Button 
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Underline Text 

An underlined portion of text appears with an underline and we use the underlined 

portion of text to make it more distinguished from other text. It is very simple to change the 

selected text into underlined font by following two simple steps – 

Step 1 − Select the portion of text which needs to be underlined. You can use any of the 

text selection method to select the portion of text. 

Step 2 − Click Font Underline [ U ] button in the Home tab Font group, or simply use 

the Ctrl + U keys to put an underline under the text. 

Change Text to Sentence Case 

A sentence case is the case where the first character of every sentence is capitalized. It 

is very simple to change the selected portion of text into sentence case by following two simple 

steps – 

Step 1 − Select the portion of text that that needs to be put in sentence case. You can 

use any of the text selection methods to select the portion of text. 

Step 2 − Click the Change Case button and then select the Sentence Case option to 

capitalize the first character of every selected sentence. 

 

 

 
 

 

 

Change Case button 
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Change Font Color 

The text that we type comes in black by default; you can always change the color of the 

font to a color of your choice. It is very simple to change the text color by following two simple 

steps – 

Step 1 − Select the portion of text the font color of which needs to be changed. You can 

use any of the text selection method to select the portion of text. 

Step 2 − Click the Font Color button triangle to display a list of colors. Try to move your 

mouse pointer over different colors and you will see the text color will change 

automatically. You can select any of the colors available by simply clicking over it. 

 

 

 

Text Alignment 

There are four types of paragraph alignment available in Microsoft Word — left-aligned, 

center-aligned, right-aligned, and justified. 

Left Aligned 

A paragraph's text is left aligned when it is aligned evenly along the left margin. Here is a 

simple procedure to make a paragraph text left-aligned. 

Font Color Button 
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Step 1 − Click anywhere on the paragraph you want to align and click the Align Text 

Left button available on the Home tab or simply press the Ctrl + L keys. 

Center Aligned 

A paragraph's text will be said center aligned if it is in the center of the left and right 

margins. Here is a simple procedure to make a paragraph text center aligned. 

Step 1 − Click anywhere on the paragraph you want to align and click the Center button 

available on the Home tab or simply press the Ctrl + E keys. 

Right Aligned 

A paragraph's text is right-aligned when it is aligned evenly along the right margin. Here 

is a simple procedure to make a paragraph text right-aligned. 

Step 1 − Click anywhere on the paragraph you want to align and click the Align Text 

Right button available on the Home tab or simply press the Ctrl + R keys. 

Justified Text 

A paragraph's text is justified when it is aligned evenly along both the left and the right 

margins. Following is a simple procedure to make a paragraph text justified. 

Step 1 − Click anywhere on the paragraph you want to align and click the Justify button 

available on the Home tab or simply press the Ctrl + J keys 

 

 
 

 

 

Create Bullets in Word 

Microsoft word provides bullets and numbers to put a list of items in a nice order. This is 

very simple to convert a list of lines into a bulleted or numbered list. Following are the simple 

steps to create either bulleted list or numbered list. 

Step 1 − Select a list of text to which you want to assign bullets or numbers. You can use 

any of the text selection method to select the portion of text. 

Step 2 − Click the Bullet Button triangle to display a list of bullets you want to assign to 

the list. You can select any of the bullet style available by simply clicking over it. 

Justify Left 

Center Right 
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Step 3 − If you are willing to create a list with numbers, then click the Numbering 

Button triangle instead of the bullet button to display a list of numbers you want to 

assign to the list. You can select any of the numbering style available by simply clicking 

over it. 

 

 

 
 

 

Set Line Spacing 

A line spacing is the distance between two lines in a Microsoft Word document. You can 

increase or decrease this distance as per your requirement by following a few simple steps. 

Following are the simple steps to adjust spacing between two lines of the document. 

Step 1 − Select the paragraph or paragraphs for which you want to define spacing. You 

can use any of the text selection method to select the paragraph(s). 

Step 2 − Click the Line and Paragraph Spacing Button triangle to display a list of options 

to adjust space between the lines. You can select any of the option available by simply 

clicking over it. 

 

 

 

 

 

Bullet Button 
Numbering Button 
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Borders and Shades 

Microsoft Word allows you to place a border on any or all of the four sides of selected 

text, paragraphs, and pages. You can also add different shades to the space occupied by the 

selected text, paragraphs, and pages. This chapter will teach you how to add any of the 

borders (left, right, top or bottom) around a text or paragraph or a page and how to add 

different shadows to them.  

Following are the simple steps to add border to any text or paragraph. 

Step 1 − Select the portion of text or paragraph to which you want to add border. You 

can use any of the text selection method to select the paragraph(s). 

Step 2 − Click the Border Button to display a list of options to put a border around the 

selected text or paragraph. You can select any of the option available by simply clicking 

over it. 

 

 

 

 

Line and Paragraph Spacing Button 

Line Spacing 
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Formatting Pages 

Adjust Page Margin 

Margins are the space between the edge of the paper and the text. You can adjust the 

right, left, top, and bottom margins of your document. By default, Word sets all margins left, 

right, top, and bottom to 1 inch. 

 The following steps will help you understand how to set margins for an open document. 

Step 1 − Open the document the margins of which need to be set. If you want the 

margins to be applied only to a selected part of a document, select that particular part. 

Step 2 − Click the Page Layout tab, and click the Margins button in the Page Setup 

group. This will display a list of options to be selected but you have to click the Custom 

Margins option available at the bottom. 

You can also select any of the predefined margins from the list, but using custom 

margins option you will have more control on all the settings. 

 

Border Button 
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Add Header and Footer 

Headers and footers are parts of a document that contain special information such as 

page numbers and the total number of pages, the document title, company logo, any photo, 

etc. The header appears at the top of every page, and the footer appears at the bottom of 

every page. 

The following steps will help you understand how to add header and footer in a Word 

document. 

Step 1 − Click the Insert tab, and click either the Header button or the Footer 

button that which needs to be added first. Assume you are going to add Header; when 

you click the Header button it will display a list of built-in Headers from where you can 

choose any of the headers by simply clicking on it. 

 

 

 

 

 

 

Margin Button 
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Add Page Number 

Microsoft Word automatically assigns page numbers on the pages of your document. 

Typically, page numbers are printed either in header or footer but you have the option that can 

display the page number in the left or right margins at the top or the bottom of a page. 

Following are the simple steps to add page numbers in a Word document. 

Step 1 − Click the Insert tab, and click the Page Number button available in the header 

and footer section. This will display a list of options to display the page number at the 

top, bottom, current position etc. 

 

 

 

 

 

 

 

 

Header Button 

Footer Button 

Edit Header Button 
Remove Header Button 
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Page Cover 

Almost all the good documents and books have an attractive first page that includes the 

document title, its subject, author and publisher name etc. This first page is the Cover 

Page and Microsoft Word provides an easy way to add a cover page. Following are the simple 

steps to add a cover page in a Word document. 

Step 1 − Click the Insert tab, and click the Cover Page button available in the Pages 

group. This will display a list of Built-in Cover Pages as shown below. 

 

 

 

 

 

 

 

Page Number Button 

Option Menu 
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Tables in Microsoft Word 

A table is a structure of vertical columns and horizontal rows with a cell at every 

intersection. Each cell can contain text or graphics, and you can format the table in any way you 

want. Usually the top row in the table is kept as a table header and can be used to put some 

informative instruction. 

 

Create Table 

The following steps will help you understand how to create a table in a Word document. 

Step 1 − Click the Insert tab followed by the Table button. This will display a simple grid 

as shown below. When you move your mouse over the grid cells, it makes a table in the 

table that appears in the document. You can make your table having the desired 

number of rows and columns. 

 

 

 

 

Cover Page Button 
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Step 2 − Click the square representing the lower-right corner of your table, which 

will create an actual table in your document and Word goes in the table design 

mode. The table design mode has many options to work with as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Table Button 
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Step 3 − this is an optional step that can be worked out if you want to have a 

fancy table. Click the Table Styles button to display a gallery of table styles. 

When you move your mouse over any of the styles, it shows real time preview of 

your actual table. 

 

 

 

 

 

 

 

 

 

 

 

 

Table Style Options Table Style 
Table Style Option 
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Step 4 − to select any of the styles, just click the built-in table style and you will 

see that the selected style has been applied on your table. 

 

Rows and Columns in Word 

A table is a structure of vertical columns and horizontal rows with a cell at every 

intersection. A Word table can contain as many as 63 columns but the number of rows is 

unlimited. 

 

Add a Row 

Following are the simple steps to add rows in a table of a word document. 

Step 1 − Click a row where you want to add an additional row and then click the Layout 

tab; it will show the following screen. 

  

 

 

Gallery Table Styles 
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Add a Formula  

Microsoft Word allows you to use mathematical formula in table cells which can be used 

to add numbers, to find the average of numbers, or find the largest or the smallest number in 

table cells you specify. There is a list of formulae, you can choose from the many based on the 

requirement. 

Following are the simple steps to add formula in a table cell available in Word 

document. 

Step 1 − Consider the following table with the total number of rows. Click in a cell that 

should contain the sum of the rows. 

 

 

Layout Tab 

Row & Column group 
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Step 2 − Now click the Layout tab and then click the Formula button; this will display a 

Formula Dialog Box which will suggest a default formula, which is =SUM (LEFT) in our 

case. You can select a number format using Number Format List Box to display the 

result or you can change the formula using the Formula List Box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Formula Button 
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Step 3 − Now click OK to apply the formula and you will see that the left cells have been 

added and the sum has been put in the total cell where we wanted to have it. You can 

repeat the procedure to have the sum of other two rows as well. 

 

Selected Formula 
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Cell Formulae 

The Formula dialog box provides the following important functions to be used as 

formula in a cell. 

No Formula & Description 

1 
AVERAGE( ) 

The average of a list of cells 

2 

COUNT( ) 

The number of items in a list of cells 

3 

MAX( ) 

The largest value in a list of cells 

4 

MIN( ) 

The smallest value in a list of cells 
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5 

PRODUCT( ) 

The multiplication of a list of cells 

6 

SUM( ) 

The sum of a list of cells 

 

 

Table of Content 

A table of contents is a list of headings in the order in which they appear in the 

document. You can set a list of headings which should be a part of the table of contents. Let us 

learn how to create a Table of Contents. A table of content helps in navigating through a Word 

document by providing associated page numbers and direct links to various headings available 

on those pages. 

 The following will help you to create Table of Contents in your Microsoft Word using 

various levels of headings. 

Step 1 − you can insert a table of content anywhere in the document, but the best place 

is always at the beginning of the document. So bring your insertion point at the 

beginning of the document and then click the References tab followed by the Table of 

Content button; this will display a list of Table of Contents options. 
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Printing Document 

Consider you are done with previewing and proofing your document and ready for the 

final printing. The following steps will help you print your Microsoft Word document. 

Step 1 − Open the document for which you want to see the preview. Next click 

the File tab followed by the Print option which will display a preview of the document 

in the right column. You can scroll up or scroll down your document to walk through the 

document using given Scrollbar. The middle column gives various options to be set 

before you send your document to the printer. 

 

 

 

 

 

 

 

 

References Tab 
Table of Contents Button 
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Step 2 − you can set various other printing options available. Select from among the 

following options, depending on your preferences. 

 

 

 

Printing Option 

Document Preview 

Print Copies 
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No Option and Description 

1 
Copies 

Set the number of copies to be printed; by default, you will have one copy of the document. 

2 

Print Custom Range 

This option will be used to print a particular page of the document. Type the number 

in Pages option, if you want to print all the pages from 7 till 10 then you would have to specify this 

option as 7-10 and Word will print only 7th, 8th, 9th and 10th pages. 

3 

Print One Sided 

By default, you print one side of the page. There is one more option where you will turn up your 

page manually in case you want to print your page on both sides of the page. 

4 

Collated 

By default, multiple copies will print Collated; if you are printing multiple copies and you want the 

copies uncollated, select the Uncollated option. 

5 Orientation 



74 
www.teampiccolo.com 

By default, page orientation is set to Portrait; if you are printing your document in landscape mode 

then select the Landscape mode. 

6 

A4 

By default, the page size is A4, but you can select other page sizes available in the dropdown list. 

7 

Custom Margin 

Click the Custom Margins dropdown list to choose the document margins you want to use. For 

instance, if you want to print fewer pages, you can create narrower margins; to print with more 

white space, create wider margins. 

8 

1 Page Per Sheet 

By default, the number of pages per sheet is 1 but you can print multiple pages on a single sheet. 

Select any option you like from the given dropdown list by clicking over the 1 Page Per Sheet option. 

 

Step 3 − Once you are done with your setting, click on the Print button which will send 

your document to the printer for final printing. 
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Print Button 
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Microsoft PowerPoint 
Microsoft PowerPoint is a commercial presentation application written and distributed 

by Microsoft for Microsoft Windows and Mac OS X.  

Microsoft PowerPoint is a presentation tool that supports text, shapes, graphics, 

pictures and multimedia along with integration with other Microsoft Office products like Excel. 

Getting Started with Microsoft PowerPoint 

In this section, we will discuss how to get started with Microsoft PowerPoint. We will 

understand how to start a Microsoft PowerPoint application in simple steps. Assuming you 

have Microsoft PowerPoint installed in your PC, to start the application, follow these steps – 

Step 1: 

 

 

 

 

 

 

 

Click on the Windows button 
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Step 2: 

 

 

Step 3: 

 

 

NB: I have installed Microsoft PowerPoint 2013 on my PC, the procedure will work on both 

later and earlier version of Microsoft PowerPoint. 

 

 

 

Click on the Search Button 

Type PowerPoint inside the search box and 

PRESS the ENTER button on your keyboard 
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Step 4: We have successfully started our Microsoft PowerPoint 

 

 

Step 5: 

 

 

 

 

 

Click on Blank Presentation 
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Exploring Window in Microsoft Word 

 

 

 

 

 

 

 

 

File Tab 

This tab opens the backstage view which basically allows you to manage the file and 

settings in PowerPoint. You can save presentations, open existing ones and create new 

presentations based on blank or predefined templates. The other file related operations can 

also be executed from this view. 

 

 

 

 

File Tab 
Home Ribbon Title Bar Slide Side 

Slide Tab Notes Selection Slide Views 

Zoom Options 
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Ribbon 

 

 The ribbon contains three components − 

 Tabs − they appear across the top of the Ribbon and contain groups of related 

commands. Home, Insert, Design are examples of ribbon tabs. 

 Groups − they organize related commands; each group name appears below the group 

on the Ribbon. For example, a group of commands related to fonts or a group of 

commands related to alignment, etc. 

 Commands − Commands appear within each group as mentioned above. 

 

Title Bar 

This is the top section of the window. It shows the name of the file followed by the 

name of the program which in this case is Microsoft PowerPoint. 

Slide Area 

This is the area where the actual slide is created and edited. You can add, edit and 

delete text, images, shapes and multimedia in this section. 

Zoom Option 

The zoom control lets you zoom in for a closer look at your text. The zoom control 

consists of a slider that you can slide left or right to zoom in or out, you can click on the - and + 

buttons to increase or decrease the zoom factor. The maximum zoom supported by PowerPoint 

is 400% and the 100% is indicated by the mark in the middle. 

Slide View 

The group of four buttons located to the left of the Zoom control, near the bottom of the 

screen, lets you switch between PowerPoint views. 

 Normal Layout view − this displays page in normal view with the slide on the right and 

a list of thumbnails to the left. This view allows you to edit individual slides and also 

rearrange them. 
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 Slide Sorter view − this displays all the slides as a matrix. This view only allows you to 

rearrange the slides but not edit the contents of each slide. 

 Reading View − this view is like a slideshow with access to the Windows task bar in case 

you need to switch windows. However, like the slideshow you cannot edit anything in 

this view. 

Notes Section 

This sections allows you to add notes for the presentation. These notes will not be 

displayed on the screen during the presentation; these are just quick reference for the 

presenter. 

Slide Tab 

This section is available only in the Normal view. It displays all the slides in sequence. 

You can add, delete and reorder slides from this section. 
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Create Presentation using PowerPoint 

PowerPoint offers a host of tools that will aid you in creating a presentation. These tools 

are organized logically into various ribbons in PowerPoint. The table below describes the 

various commands you can access from the different menus. 

 

 

Menu Category Ribbon Commands 

Home Clipboard functions, manipulating slides, fonts, paragraph settings, drawing 

objects and editing functions. 

Insert Insert tables, pictures, images, shapes, charts, special texts, multimedia and 

symbols. 

Design Slide setup, slide orientation, presentation themes and background. 

Transitions Commands related to slide transitions. 

Animations Commands related to animation within the individual slides. 

Slide Show Commands related to slideshow set up and previews. 

Review Proofing content, language selection, comments and comparing presentations. 

View Commands related to presentation views, Master slides, color settings and 

window arrangements. 

 

Menu Categories 
Ribbon Command 
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Add New Slide in PowerPoint 

Step 1: Right-click in the Navigation Panel under any existing slide and click on the New 

Slide option. 

 

 

 

Step 2: The new slide is inserted. You can now change the layout of this slide to suit your design 

requirements. 

 

Navigation Panel 

New Slide inserted 
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Step 3: To change the slide layout, right-click on the newly inserted slide and go to 

the Layout option where you can choose from the existing layout styles available to you. 

 

 

 

 

You can follow the same steps to insert a new slide in between existing slides or at the 

end on the slide list. 

When we insert a new slide, it inherits the layout of its previous slide with one 

exception. If you are inserting a new slide after the first slide (Title slide), the subsequent slide 

will have the Title and Content layout. 

You will also notice that if you right-click in the first step without selecting any slide the 

menu options you get are different, although you can insert a new slide from this menu too. 

 

 

 

 

 

Layout Menu Option 

Slide Layout Style 
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Adding Text in Boxes in PowerPoint 

PowerPoint allows users to add text to the slide in a well-defined manner to ensure the 

content is well distributed and easy to read. The procedure to add the text in a PowerPoint 

slide is always the same - just click in the text box and start typing. The text will follow the 

default formatting set for the text box, although this formatting can be changed later as 

required. What changes is the different kinds of content boxes that support text in a 

PowerPoint slide. 

Given below are some of the most common content blocks you will see in PowerPoint. 

Title Box 

This is typically found on slides with the title layout and in all the slides that have a title 

box in them. This box is indicated by "Click to add title". 

Subtitle Box 

This is found only in slides with the Title layout. This is indicated by "Click to add 

subtitle"  

 

 

 

 

 

Title Box 

Subtitle Box 
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Content Box 

This is found in most of the slides that have a placeholder for adding content. This is 

indicated by "Click to add text". As you can see, this box allows you to add text as well as non-

text content. To add text to such a box, click anywhere on the box, except on one of the 

content icons in the center and start typing. 

 

 

Adding New Text Box in PowerPoint 

Step 1: Click on the Text Box icon in the Home ribbon under the Drawing section.  

 

 

 

Step 2: You will get the insert text box cursor that looks like an inverted cross. 

 

 

 

Non-Text content 

Text Box 
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Step 3: Click to insert a text box. You can now start typing directly into the text box 

 

 

Deleting Existing Slide in PowerPoint 

There are times while creating a presentation, you may need to delete some slides. This 

can be done easily from PowerPoint. 

Step 1: Right-click on the slide to be deleted and select the Delete Slide option. 

New Inserted Text Box 
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Rearranging Slide in PowerPoint 

Rearranging slides is important when it comes to organizing the overall presentation 

flow. While it is vital that you get the right content in every slide, it is equally important that 

you are able to present them in a format that makes it easier for the audience to understand 

the content too; most times this will require rearranging the slides. 

To rearrange your slide, follow the following steps below: 

Step 1: Left click on the slide and drag it to the position in the sequence where you want to 

place it. PowerPoint will indicate the insert position with a line in-between existing slides. 

Click on the Delete Slide 
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Inserted Slide;  

NB: This Slide was the second slide in our 

presentation but we moved it to the third slide 
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Step 2: When you get to the right position release the left click button to insert the slide. 

Alternately you can also cut the selected slide and paste it back in the sequence as shown 

below. 
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Adding Slide Notes 

Slide notes can be very useful tools for presentation. These notes are not displayed on 

the screen in the Slideshow mode, but the presenter can see them so they can prepare well to 

present the slides. Depending on your Print settings, you can also print the slide notes along 

with the slides. To add notes to your slide, follow the following steps below: 

Step 1: 

 

Step 2: Type your text in this section as slide notes. 

 

Type your text here 

Click on the NOTES button 
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NB: Slide notes can be printed from the print menu under the backstage view. From the Print 

Layout option, select Notes Pages or 3 Slides. Notes Pages will print a single slide with the slide 

notes below it. The 3 Slides will print all three slides with notes on the right side. 

 

 

 

Presentation Views in PowerPoint 

PowerPoint supports multiple views to allow users to gain the maximum from the 

features available in the program. Each view supports a different set of functions and is 

designed accordingly. 

PowerPoint views can be accessed from two locations. 

 Views can be accessed quickly from the bottom bar just to the left of the zoom settings. 

Print Menu 

Print Menu Layout 

Notes Option 

3 Slides Option 
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 Views can also be accessed from the Presentation Views section in the View ribbon 

 

 

 

 

 

 

 

 

 

 

Quick Access to Presentation View 

View Ribbon 

Presentation Views 
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Normal View 

This is the default view in PowerPoint and this is primarily used to create and edit slides. 

You can create/ delete/ edit/ rearrange slides, add/ remove/ modify content and manipulate 

sections from this view. 

 

Slide Sorter View 

This view is primarily used to sort slides and rearrange them. This view is also ideal to 

add or remove sections as it presents the slides in a more compact manner making it easier to 

rearrange them. 
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Reading View 

This view was introduced in PowerPoint 2010 and it was created mainly to review the 

slideshow without losing access to rest of the Windows applications. Typically, when you run 

the slideshow, the presentation takes up the entire screen so other applications cannot be 

accessed from the taskbar. In the reading view the taskbar is still available while viewing the 

slideshow which is convenient. You cannot make any modifications when on this view. 

 

Slide Show 

This is the traditional slideshow view available in all the earlier versions of PowerPoint. 

This view is used to run the slideshow during presentation. 
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Setting Backgrounds in PowerPoint 

As PowerPoint is a design-based program, backgrounds are effective ways of improving 

the aesthetics and readability of the slides. The Themes in PowerPoint help select the 

backgrounds by default, so every time you change the theme, the default background is set 

automatically. Theme includes more than just backgrounds, so you can retain other aspects of 

the theme while changing the default background. 

To apply backgrounds in PowerPoint, follow the steps below: 

Step 1: In the Design ribbon, click on the More button 

 

Step 2: Select one of the background styles that suits your requirements. 

 

 

Click on the more button 
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Adding Slide Numbers in PowerPoint 

Just like you have page numbers for books, it is usually a good idea to add slide 

numbers to presentations. There are two ways you can add slide numbers to your 

presentation and this chapter will show you both those techniques. 

Step 1: Under the Insert ribbon, click on Slide Number command. 

 

 

Step 2: Check the Slide number check box. 

 

 

Click on Slide Number 

Check on Slide Number 
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Adding Header and Footer in PowerPoint 

PowerPoint offers the ability to add header and footers to the slides. While having 

footers in presentations is logical, header may not be quite evident at first. Typically, the slide 

title would be the header in the main slide, however when it comes to printing out handouts a 

separate header would be quite useful. 

Here are the steps to add header and footer information to slides 

Step 1: In the Insert ribbon, click on the Header & Footer menu item. 

 

Step 2: The Header and Footer dialog has two tabs — the Slide tab and the Notes and 

Handouts tab. 

 

 

 

 

 

 

 

 

Click on Header & Footer button 
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Step 3: You can add details to the slide footer from the Slide tab. 

 

 

No Slide Footer Options & Description 

1 Date and time 

 Add date and time to the footer 

 Specify the format of the date and time entered 

 Set up the footer to update automatically or use a fixed number 

2 Slide Number 

Insert Slide number in the footer 

3 Footer 

Add designated text to the footer - a good example of this is the confidentiality clause or copyright 

clause 

4 Don't show on title slide 

Decide on whether the footer information should be displayed on the title slide or not 

 

 

Slide Tab 
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Step 4: You can add the details to the handouts from the Notes and Handouts tab. 

 

No Notes and Handouts Options & Description 

1 Date and time 

 Add date and time to the footer 

 Specify the format of the date and time entered 

 Set up the footer to update automatically or use a fixed number 

2 Header 

Add the header information for every page on the handout 

3 Page Number 

Insert page number in the footer 

4 Footer 

Add designated text to the footer - a good example of this is the confidentiality clause or copyright 

clause 

 

 

Notes & Handouts 

tab 
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Running Slide Show in PowerPoint 

Most PowerPoint presentations are created to be run as a slideshow. It is no surprise 

that there are many features related to running the slideshow that have been included in this 

program too. Most of these features are really to help you create a good slideshow without 

having to go through the entire presentation over and over again after every minor change. 

Features related to running the slideshow are grouped under the Slideshow ribbon. 

 

 

 

 

Section Menu Item Description 

Start Slideshow From Beginning Starts slideshow from beginning 

From Current Slide Starts slideshow from the current slide 

Broadcast Slideshow 
Allows users to broadcast the slideshows using 

Microsoft's PowerPoint Broadcast Service 

Custom Slideshow 
Builds a custom slideshow by picking the slides 

you want to run 

Set Up 

Set Up Slideshow 

Helps set up the slideshow including browser/ full 

screen display, show options with or without 

narration/ animation, pen and laser color during 

the slideshow and the slides to be presented 

during the show 

Hide Slide Helps mark/ unmark the slide as hidden, so it is 

skipped or shown during the slideshow 

Slide Show Ribbon 
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respectively 

Rehearse Timing 
Allows users to rehearse the timing on each slide 

and the entire slideshow 

Record Slideshow 
Records the slideshow including narration and 

animation 

Slideshow Checkboxes 

Helps set or avoid the use of narrative audio and 

rehearsed timings during the show. Display 

media controls in the slideshow view 

Monitors Resolution Defines resolution in slideshow view 

Show Presentation on 
Picks the monitor to display the presentation one 

- in case of multiple monitors 

Use Presenter View 
Run presentation in Presenter view rather than 

just slideshow view 
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Saving Presentation in PowerPoint 

One of the most basic tasks in PowerPoint is being able to save your work; this is 

probably the most important task as well. There are many users who have burnt their fingers 

for not saving their work in time and losing hours of hard work. The following are the basic 

steps to save a presentation. 

Step 1: Click on the File tab to launch the backstage view and select Save. 

 

 

 

 

 

 

 

 

 

 

 

Click on the Save Button 
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Step 2: 

 

 

Step 3: 

 

 

Click on Browse to locate 

where you want to save the 

presentation on your PC 

Type in the name 

of the presentation 

Click on the Save button 
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Microsoft Excel 
Microsoft Excel is a commercial spreadsheet application, written and distributed by 

Microsoft for Microsoft Windows and Mac OS X.  

Microsoft Excel is a spreadsheet tool capable of performing calculations, analyzing data 

and integrating information from different programs. 

Getting Started with Microsoft Excel 

In this section, we will discuss how to get started with Microsoft Excel. We will 

understand how to start a Microsoft Excel application in simple steps. Assuming you have 

Microsoft Excel installed in your PC, to start the application, follow these steps – 

Step 1: 

 

 

 

 

 

 

 

Click on the Windows button 
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Step 2: 

 

Step 3: 

 

 

NB: I have installed Microsoft Excel 2013 on my PC, the procedure will work on both later and 

earlier version of Microsoft Excel. 

Click on the Search button 

Type Excel in the search box and PRESS the 

ENTER button on your keyboard 
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Step 4: 

 

 

Step 5: 

 

 

Click on Blank Workbook 
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Exploring Window in Microsoft Excel 

 

 

 

 

 

 

 

File Tab 

The File tab replaces the Office button from Excel 2007. You can click it to check 

the backstage view, where you come when you need to open or save files, create new sheets, 

print a sheet, and do other file-related operations 

Ribbon 

 

Ribbon contains commands organized in three components − 

File Tab 
Ribbon 

Title Bar 

Row Bar 

Column Bar 

Sheet Area 

Status Bar 

View Button 

Zoom Control 
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 Tabs: They appear across the top of the Ribbon and contain groups of related 

commands. Home, Insert, Page Layout are the examples of ribbon tabs. 

 Groups: They organize related commands; each group name appears below the group 

on the Ribbon. For example, group of commands related to fonts or group of 

commands related to alignment etc. 

 Commands: Commands appear within each group as mentioned above. 

Title Bar 

This lies in the middle and at the top of the window. Title bar shows the program and 

the sheet titles. 

Zoom Control 

Zoom control lets you zoom in for a closer look at your text. The zoom control consists 

of a slider that you can slide left or right to zoom in or out. The + buttons can be clicked to 

increase or decrease the zoom factor. 

View Button 

The group of three buttons located to the left of the Zoom control, near the bottom of the 

screen, lets you switch among excels various sheet views. 

 Normal Layout view: This displays the page in normal view. 

 Page Layout view: This displays pages exactly as they will appear when printed. This 

gives a full screen look of the document. 

 Page Break view: This shows a preview of where pages will break when printed. 

Sheet Area 

The area where you enter data. The flashing vertical bar is called the insertion point and 

it represents the location where text will appear when you type. 

Row Bar 

Rows are numbered from 1 onwards and keeps on increasing as you keep entering data. 

Maximum limit is 1,048,576 rows. 

Column Bar 

Columns are numbered from A onwards and keeps on increasing as you keep entering 

data. After Z, it will start the series of AA, AB and so on. Maximum limit is 16,384 columns. 
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Status Bar 

This displays the sheet information as well as the insertion point location. From left to 

right, this bar can contain the total number of pages and words in the document, language etc. 

You can configure the status bar by right-clicking anywhere on it and by selecting or 

deselecting options from the provided list. 

 

Entering Values in Microsoft Excel 

 

 

Sheet area is the place where you type your text. The flashing vertical bar is called the 

insertion point and it represents the location where text will appear when you type. When 

you click on a box then the box is highlighted. When you double click the box, the flashing 

vertical bar appears and you can start entering your data. 

So, just keep your mouse cursor at the text insertion point and start typing whatever 

text you would like to type. We have typed only two words "Excel Tutorial" as shown below. 

The text appears to the left of the insertion point as you type. 

Sheet Area 
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There are three (3) important points, which would help you while typing − 

 Press Tab to go to next column. 

 Press Enter to go to next row. 

 Press Alt + Enter to enter a new line in the same column. 
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Saving Workbook in Microsoft Excel 

Once you are done with typing in your new excel sheet, it is time to save your 

sheet/workbook to avoid losing work you have done on an Excel sheet. Following are the steps 

to save an edited excel sheet − 

Step 1: Click the File tab and select Save As option. 

 

 

 

 

 

 

 

 

 

 

 

Click on Save As 
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Step 2: Select a folder where you would like to save the sheet, Enter file name, which you want 

to give to your sheet and Click on Save. 

 

 

Creating New Worksheet in Microsoft Excel 

The following steps below explain you how to create a new worksheet if you want to 

start another new worksheet while you are working on a worksheet, or you closed an already 

opened worksheet and want to start a new worksheet. 

 

 

 

 

 

 

 

 

 

Enter the file name 

Click on the Save button 
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Step 1: Right Click the Sheet Name and select Insert option. 

 

 

 

Step 2 − Now you'll see the Insert dialog with select Worksheet option as selected from the 

general tab. Click the Ok button. 

 

Right Click on Sheet name 

Click on Insert button 

Click on Ok button 
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Now you should have your blank sheet as shown below ready to start typing your text. 

 

You can use a short cut to create a blank sheet anytime. Try using the Shift+F11 keys and you 

will see a new blank sheet similar to the above sheet is opened. 

Or you can follow the steps below to create a new worksheet in Microsoft Excel 

Step 1: 

 

Click on the New Sheet button 
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Step 2: 

 

 

Copying Worksheet in Microsoft Excel 

First of all, let us create some sample text before we proceed. Open a new excel sheet 

and type any data. We've shown a sample data in the screenshot below. 

 

New Sheet inserted 



119 
www.teampiccolo.com 

Here are the steps to copy an entire worksheet. 

Step 1: Right Click the Sheet Name and select the Move or Copy option. 

 

Step 2: Now you'll see the Move or Copy dialog with select Worksheet option as selected from 

the general tab. Click on the Ok button. 

 

Select Move or Copy option 

Select Option to add sheet 

at the end 

Check this option if 

you want copy sheet 
Click on the OK button 
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Now you should have your copied sheet as shown below. 

 

NB: You can rename the sheet by double clicking on it. On double click, the sheet name 

becomes editable. Enter any name say Sheet7 copied and press Tab or Enter button on your 

keyboard. 

 

Delete Worksheet in Microsoft Excel 

You might need to delete your worksheet for one or more reasons. To delete a 

worksheet in Microsoft Excel, follow the steps below. 

 

 

 

 

 

 

 

 

 

 

The Copied sheet 
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Step 1: Right Click the Sheet Name and select the Delete option. 

 

Step 2: Sheet will get deleted if it is empty, otherwise you'll see a confirmation message. 

 

 

Click on the Delete option 

Click on the Delete button 
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Close a Worksheet in Microsoft Excel 

After working on your Sheet in Microsoft Excel, you can close the sheet; to close a sheet 

in Microsoft Excel, follow the following steps below:  

Step 1: Click the Close Button as shown below. 

 

 

NB: if you haven’t save your save, you'll see a confirmation message to save the workbook. 

 

 

 

 

 

 

 

 

Click on the Close button 
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Editing Worksheet in Microsoft Excel 

In Microsoft Excel, there are 1048576*16384 cells. Microsoft Excel cell can have Text, 

Numeric value or formulas. An MS Excel cell can have maximum of 32000 characters. 

Rows and Columns in Microsoft Excel 

Microsoft Excel is in tabular format consisting of rows and columns. 

 Row runs horizontally while Column runs vertically. 

 Each row is identified by row number, which runs vertically at the left side of the sheet. 

 Each column is identified by column header, which runs horizontally at the top of the 

sheet. 

Row numbers ranges from 1 to 1048576; in total 1048576 rows, and Columns ranges 

from A to XFD; in total 16384 columns. 

 

 

 

 

 

Columns 

Rows 
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Cell Introduction 

The intersection of rows and columns is called cell. Cell is identified with Combination 

of column header and row number. For example − A1, A2. 

 

Inserting Data 

To insert data in Microsoft Excel, just activate the cell; type text example “Kabir Yusuf 

Bashir” or number example “1929292” and press enter or Navigation keys. 

 

Active cell for data insertion 

Intersection of column C and row 3 makes cell C3 

Cell Number in Name Box 



125 
www.teampiccolo.com 

Inserting Formula 

To insert formula in Microsoft Excel go to the formula bar, enter the formula and then 

press enter or navigation key. See the screen-shot below to understand it. 

 

 

NB: I sum the months; January, February, March and April for the employee Kabir Yusuf 

Bashir. 

 

 

 

 

 

 

 

 

 

 

Entering formula in MS Excel 
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Select Data in Microsoft Excel 

Selecting data in Microsoft Excel is vital especially when you want to print a particular 

section in your worksheet. To select data in Microsoft Excel, follow the steps below: 

Step 1: Drag the mouse over the data you want to select. It will select those cells as shown 

below. 

 

Delete Data in Microsoft Excel 

To delete a data in Microsoft Excel, follow the steps below: 

Step 1: Select the data you want to delete. Right Click on the sheet. Select the delete option, to 

delete the data. 

 

 

Selected data 

Select the Delete option 
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NB: Or you can use the Delete button on your keyboard after selecting the data you want to 

delete. 

Move Data in Microsoft Excel 

Sometimes you might need to move your data from the top of your worksheet to the 

bottom or from the right to the left. To move data in Microsoft Excel, follow the steps below: 

Step 1 − Select the data you want to Move. Right Click and Select the cut option. 

 

Step 2 − Select the first cell where you want to move the data. Right click on it and paste the 

data. You can see the data is moved now. 

 

 

 

Select the Cut option 

Moved data 
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Find and Replace in Microsoft Excel 

Microsoft Excel provides Find & Replace option for finding text within the sheet. To find 

and replace a text in Microsoft Excel, follow the steps below: 

Step 1: To access the Find & Replace, Choose Home → Find & Select → Find or press Control + 

F Key. See the image below. 

 

Step 2: You can see the Find and Replace dialog box as below. 

 

 

Select the Find option 

Replace Tab 

Text to Find 

Text to Replace 
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Special Symbols in Microsoft Excel 

If you want to insert some symbols or special characters that are not found on the 

keyboard in that case you need to use the Symbols option.  

Step1: Go to Insert » Symbols » Symbol to view available symbols. You can see many symbols 

available there like Pi, alpha, beta, etc. 

 

Step 2: Choose your desire symbol you want to use and click on the Insert button  

 

 

Click on the Symbol button 

Click on the Insert button 
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Formatting Cells in Microsoft Excel 

Setting Cell Type 

Microsoft Excel Cell can hold different types of data like Numbers, Currency, Dates, etc. 

You can set the cell type by following the steps below: 

Step1: Right Click on the cell and select the Format cells option. 

 

Step 2: 

 

Select the option Format Cells… 

Select Cell Format 
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Setting Fonts in Microsoft Excel 

Step 1: 

 

NB: You can selected more than one cell and assign the font face or font size to those cells. 

Text Decoration in Microsoft Excel 

You can change the text decoration of the cell to change its look and feel. 

Step 1: 

 

Setting Font Face 

Setting Font Size 

Make Text Bold 

Make Text Italic 

Make Text Underlined 
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Rotate Cells in Microsoft Excel 

You can rotate the cell by any degree to change the orientation of the cell. 

Step 1: Click on the orientation in the Home tab. Choose options available like Angle Counter 

Clockwise, Angle Clockwise, etc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click here to Rotate Cell Choose option to Rotate Cell 
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Changing Background Color in Microsoft Excel 

By default the background color of the cell is white in Microsoft Excel. You can change it 

as per your need from Home tab » Font group » Background color. 

 

 

Changing Foreground Color in Microsoft Excel 

By default, the foreground or text color is black in Microsoft Excel. You can change it as 

per your need from Home tab » Font group » Foreground color. 

 

 

Click on the Fill Color button 

Click on the Font Color 

button 
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Merge Cells in Microsoft Excel 

Microsoft Excel enables you to merge two or more cells. When you merge cells, you 

don’t combine the contents of the cells. Rather, you combine a group of cells into a single cell 

that occupies the same space. 

You can merge cells by various ways as mentioned below. 

 Choose Merge & Center control on the Ribbon, which is simpler. To merge cells, select 

the cells that you want to merge and then click the Merge & Center button. 

 

 

 

 

 

 

 

 

 

 

Merged Cell from D8 to I8 

Select your desire option under the 

Merge & Center button 
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Formatting Worksheet in Microsoft Excel 

Sheet Options in Microsoft Excel 

Microsoft Excel provides various sheet options for printing purpose like generally cell 

gridlines aren’t printed. If you want your printout to include the gridlines, follow the steps 

below:  

Step 1: Click on Page Layout on your Ribbon 

 

Step 2: 

 

 

Click on Sheet Page Setup 

Check this to Print Grid 

Set Print Area 
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Options in Sheet Options Dialog Box 

 Print Area: You can set the print area with this option. 

 Print Titles: You can set titles to appear at the top for rows and at the left for columns. 

 Print: 

o Gridlines: Gridlines to appear while printing worksheet. 

o Black & White: Select this check box to have your color printer print the chart in 

black and white. 

o Draft quality: Select this check box to print the chart using your printer’s draft-

quality setting. 

o Rows & Column Heading: Select this check box to have rows and column 

heading to print. 

 Page Order: 

o Down, then Over: It prints the down pages first and then the right pages. 

o Over, then Down: It prints right pages first and then comes to print the down 

pages. 

Page Orientation 

Page orientation refers to how output is printed on the page. If you change the 

orientation, the onscreen page breaks adjust automatically to accommodate the new paper 

orientation. 

Types of Page Orientation 

 Portrait − Portrait to print tall pages (the default). 

 Landscape − Landscape to print wide pages. Landscape orientation is useful when you 

have a wide range that doesn’t fit on a vertically oriented page. 
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Changing Page Orientation 

Choose Page Layout » Page Setup » Orientation » Portrait or Landscape. 

 

 

Header and Footer in Microsoft Excel 

A header is the information that appears at the top of each printed page and a footer is 

the information that appears at the bottom of each printed page. By default, new workbooks 

do not have headers or footers. To insert a Header or Footer to your worksheet, follow the 

steps below: 

 

 

 

 

 

 

 

 

Select Page Orientation 
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Step 1: Choose Page Setup dialog box » Header or Footer tab. 

 

 

Other Header and Footer Options 

When a header or footer is selected in Page Layout view, the Header & Footer » Design » 

Options group contains controls that let you specify other options − 

 Different First Page − Check this to specify a different header or footer for the first 

printed page. 

 Different Odd & Even Pages − Check this to specify a different header or footer for odd 

and even pages. 

 Scale with Document − If checked, the font size in the header and footer will be sized. 

Accordingly if the document is scaled when printed. This option is enabled, by default. 

 Align with Page Margins − If checked, the left header and footer will be aligned with 

the left margin, and the right header and footer will be aligned with the right margin. 

This option is enabled, by default. 

 

 

 

 

 

Custom Header 

Custom Footer 
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Working with Formula in Microsoft Excel 

Formulas are the Bread and butter of worksheet. Without formula, worksheet will be 

just simple tabular representation of data. A formula consists of special code, which is entered 

into a cell. It performs some calculations and returns a result, which is displayed in the cell. 

Formulas use a variety of operators and worksheet functions to work with values and 

text. The values and text used in formulas can be located in other cells, which makes changing 

data easy and gives worksheets their dynamic nature. For example, you can quickly change the 

data in a worksheet and formulas works. 

A formula can consist of any of these elements − 

 Mathematical operators, such as +(for addition) and *(for multiplication) 

Example − 

o =A1+A2 Adds the values in cells A1 and A2. 

 Values or text 

Example − 

o =200*0.5 Multiplies 200 times 0.15. This formula uses only values, and it always 

returns the same result as 100. 

 Cell references (including named cells and ranges) 

Example − 

o =A1=C12 Compares cell A1 with cell C12. If the cells are identical, the formula 

returns TRUE; otherwise, it returns FALSE. 

 Worksheet functions (such as SUM or AVERAGE) 

Example − 

o =SUM (A1:A12) Adds the values in the range A1:A12. 
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Creating Formulas in Microsoft Excel 

To create a formula you need to type in the Formula Bar. Formula begins with '=' sign. 

When building formulas manually, you can either type in the cell addresses or you can point to 

them in the worksheet.  

Using the Pointing method to supply the cell addresses for formulas is often easier and 

more powerful method of formula building. When you are using built-in functions, you click the 

cell or drag through the cell range that you want to use when defining the function’s arguments 

in the Function Arguments dialog box. See the below screen shot. 

 

 

Copying Formulas in Microsoft Excel 

MS Excel does it automatically adjusting the cell references in the original formula to 

suit the position of the copies that you make. It does this through a system known as relative 

cell addresses, where by the column references in the cell address in the formula change to 

suit their new column position and the row references change to suit their new row position. 

Let us see this with the help of example. Suppose we want the sum of all the rows at 

last, then we will write a formula for first column i.e. B. We want sum of the rows from 4 to 7 

in the 8th row. 

Formula Bar to write formula 

Result Cell 
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Formula bar Showing Formula 

Drag this to the right to copy formula with relative reference 
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Cell References in Formulas 

Most formulas you create include references to cells or ranges. These references enable 

your formulas to work dynamically with the data contained in those cells or ranges. For 

example, if your formula refers to cell C2 and you change the value contained in C2, the 

formula result reflects new value automatically. If you didn’t use references in your formulas, 

you would need to edit the formulas themselves in order to change the values used in the 

formulas. 

When you use a cell (or range) reference in a formula, you can use three types of 

references:  

 Relative 

 Absolute  

 Mixed references. 

Relative Cell Reference 

The row and column references can change when you copy the formula to another cell 

because the references are actually offsets from the current row and column. By default, Excel 

creates relative cell references in formulas. 

 

 

 

 

Formula using Relative reference 
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Absolute Cell Reference 

The row and column references do not change when you copy the formula because the 

reference is to an actual cell address. An absolute reference uses two dollar signs in its address: 

one for the column letter and one for the row number (for example, $A$5). 

 

Mixed Cell Reference 

Both the row or column reference is relative and the other is absolute. Only one of the 

address parts is absolute (for example, $A5 or A$5). 

 

 

 

Formula using Absolute reference 

Formula Using Mixed Reference 
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Using Formulas in Microsoft Excel 

Many formulas you create use available worksheet functions. These functions enable 

you to greatly enhance the power of your formulas and perform calculations that are difficult if 

you use only the operators. For example, you can use the LOG or SIN function to calculate the 

Logarithm or Sin ratio. You can’t do this complicated calculation by using the mathematical 

operators alone. 

 When you type = sign and then type any alphabet you will see the searched functions as 

below. 

 

 

 

 

 

 

 

 

 

 

Typing SU will show functions starting with SU 
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Built-in Functions in Microsoft Excel 

MS Excel has many built in functions, which we can use in our formula. To see all the 

functions by category, choose Formulas Tab » Insert Function. Then Insert function Dialog 

appears from which we can choose the function. 

 

 

Functions by Categories 

Let us see some of the built in functions in MS Excel. 

 Text Functions 

o LOWER − Converts all characters in a supplied text string to lower case 

o UPPER − Converts all characters in a supplied text string to upper case 

o TRIM − Removes duplicate spaces, and spaces at the start and end of a text 

string 

o CONCATENATE − Joins together two or more text strings. 

o LEFT − Returns a specified number of characters from the start of a supplied text 

string. 

o MID − Returns a specified number of characters from the middle of a supplied 

text string 

Function Categories 
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o RIGHT − Returns a specified number of characters from the end of a supplied 

text string. 

o LEN − Returns the length of a supplied text string 

o FIND − Returns the position of a supplied character or text string from within a 

supplied text string (case-sensitive). 

 Date & Time 

o DATE − Returns a date, from a user-supplied year, month and day. 

o TIME − Returns a time, from a user-supplied hour, minute and second. 

o DATEVALUE − Converts a text string showing a date, to an integer that 

represents the date in Excel's date-time code. 

o TIMEVALUE − Converts a text string showing a time, to a decimal that 

represents the time in Excel. 

o NOW − Returns the current date & time. 

o TODAY − Returns today's date. 

 Statistical 

o MAX − Returns the largest value from a list of supplied numbers. 

o MIN − Returns the smallest value from a list of supplied numbers. 

o AVERAGE − Returns the Average of a list of supplied numbers. 

o COUNT − Returns the number of numerical values in a supplied set of cells or 

values. 

o COUNTIF − Returns the number of cells (of a supplied range), that satisfies a 

given criteria. 

o SUM − Returns the sum of a supplied list of numbers 

 Logical 

o AND − Tests a number of user-defined conditions and returns TRUE if ALL of the 

conditions evaluate to TRUE, or FALSE otherwise 

o OR − Tests a number of user-defined conditions and returns TRUE if ANY of the 

conditions evaluate to TRUE, or FALSE otherwise. 
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o NOT − Returns a logical value that is the opposite of a user supplied logical value 

or expression i.e. returns FALSE if the supplied argument is TRUE and returns 

TRUE if the supplied argument is FAL 

 Math & Trig 

o ABS − Returns the absolute value (i.e. the modulus) of a supplied number. 

o SIGN − Returns the sign (+1, -1 or 0) of a supplied number. 

o SQRT − Returns the positive square root of a given number. 

o MOD − Returns the remainder from a division between two supplied numbers. 

 

Advanced Operations in Microsoft Excel 

Data Filtering in Microsoft Excel 

Filtering data in MS Excel refers to displaying only the rows that meet certain 

conditions. (The other rows gets hidden.) 

Using the store data, we can only display the employee Umar Grema. 

 Place a cursor on the Header Row. 

 Choose Data Tab » Filter to set filter. 

 

 

Check the option Umar Grema 
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Data Sorting in Microsoft Excel 

Sorting data in Microsoft Excel rearranges the rows based on the contents of a 

particular column. You may want to sort a table to put names in alphabetical order. Or, maybe 

you want to sort data by Amount from smallest to largest or largest to smallest. 

To Sort the data follow the steps mentioned below. 

 Select the Column by which you want to sort data. 

 Choose Data Tab » Sort Below dialog appears. 

 

Showing only Umar Grema’s record  

Click on Sort button 



149 
www.teampiccolo.com 

 

 

 

 

 

 

Column to sort 

Sorted record 
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Charts in Microsoft Excel 

A chart is a visual representation of numeric values. Charts (also known as graphs) have 

been an integral part of spreadsheets. Charts generated by early spreadsheet products were 

quite crude, but thy have improved significantly over the years. Excel provides you with the 

tools to create a wide variety of highly customizable charts. Displaying data in a well-conceived 

chart can make your numbers more understandable. Because a chart presents a picture, charts 

are particularly useful for summarizing a series of numbers and their interrelationships. 

Types of Chart in Microsoft Excel 

There are various chart types available in MS Excel, to view the various charts in 

Microsoft Excel, follow the steps below: 

Step1: 

 

 

 

 

 

 

 

Click on See All Charts button 



151 
www.teampiccolo.com 

Step 2: 

 

 

 Column: Column chart shows data changes over a period of time or illustrates 

comparisons among items. 

 Bar: A bar chart illustrates comparisons among individual items. 

 Pie: A pie chart shows the size of items that make up a data series, proportional to the 

sum of the items. It always shows only one data series and is useful when you want to 

emphasize a significant element in the data. 

 Line: A line chart shows trends in data at equal intervals. 

 Area: An area chart emphasizes the magnitude of change over time. 

 X Y Scatter: An xy (scatter) chart shows the relationships among the numeric values in 

several data series, or plots two groups of numbers as one series of xy coordinates. 

 Stock: This chart type is most often used for stock price data, but can also be used for 

scientific data (for example, to indicate temperature changes). 

 Surface: A surface chart is useful when you want to find the optimum combinations 

between two sets of data. As in a topographic map, colors and patterns indicate areas 

that are in the same range of values. 

Click on the All Charts tab 
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 Doughnut: Like a pie chart, a doughnut chart shows the relationship of parts to a 

whole; however, it can contain more than one data series. 

 Bubble: Data that is arranged in columns on a worksheet, so that x values are listed in 

the first column and corresponding y values and bubble size values are listed in 

adjacent columns, can be plotted in a bubble chart. 

 Radar: A radar chart compares the aggregate values of a number of data series. 

 

Creating Chart in Microsoft Excel 

To create charts for the data by below mentioned steps: 

 Select the data for which you want to create the chart. 

 Choose Insert Tab » Select the chart or click on the Chart group to see various chart 

types. 

 Select the chart of your choice and click OK to generate the chart. 

 

 

Click on the Chart you want 
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Printing a Worksheet in Microsoft Excel 

Sometimes, you may need to print only a specific part of your worksheet and not the 

whole worksheet, to print a particular part of your worksheet, follow the steps below: 

Step 1: Select the area you want to print 

 

The Data is presented in a Chart 
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Step 2: 

 

 

Step 3: Click on the file Tab 

 

 

Select the Set Print Area option 

Click on Print option 
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Step 4: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click on the Print button to print your worksheet 
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Microsoft Access 

Microsoft Access is a Database Management System (DBMS) from Microsoft that 

combines the relational Microsoft Jet Database Engine with a graphical user interface and 

software development tools. It is a part of the Microsoft Office suite of applications, included in 

the professional and higher editions. This is an introductory tutorial that covers the basics of MS 

Access. 

 Microsoft Access is a Database Management System (DBMS) from Microsoft that 

combines the relational Microsoft Jet Database Engine with a graphical user interface and 

software development tools. It is a member of the Microsoft Office suite of applications, 

included in the professional and higher editions. 

 Microsoft Access is just one part of Microsoft’s overall data management product 

strategy. 

 It stores data in its own format based on the Access Jet Database Engine. 

 Like relational databases, Microsoft Access also allows you to link related information 

easily. For example, customer and order data. However, Access 2013 also complements 

other database products because it has several powerful connectivity features. 

 It can also import or link directly to data stored in other applications and databases. 

 As its name implies, Access can work directly with data from other sources, including 

many popular PC database programs, with many SQL (Structured Query Language) 

databases on the desktop, on servers, on minicomputers, or on mainframes, and with 

data stored on Internet or intranet web servers. 

 Access can also understand and use a wide variety of other data formats, including 

many other database file structures. 

 You can export data to and import data from word processing files, spreadsheets, or 

database files directly. 

 Access can work with most popular databases that support the Open Database 

Connectivity (ODBC) standard, including SQL Server, Oracle, and DB2. 

 Software developers can use Microsoft Access to develop application software. 

Microsoft Access stores information which is called a database. To use MS Access, you will 

need to follow these four steps − 

 Database Creation: Create your Microsoft Access database and specify what kind of 

data you will be storing. 
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 Data Input: After your database is created, the data of every business day can be 

entered into the Access database. 

 Query: This is a fancy term to basically describe the process of retrieving information 

from the database. 

 Report (optional): Information from the database is organized in a nice presentation 

that can be printed in an Access Report. 

Microsoft Access Architecture 

 Access calls anything that can have a name an object. Within an Access desktop 

database, the main objects are tables, queries, forms, reports, macros, data macros, 

and modules. 

 If you have worked with other database systems on desktop computers, you might have 

seen the term database used to refer to only those files in which you store data. 

 But, in Access, a desktop database (.accdb) also includes all the major objects related to 

the stored data, including objects you define to automate the use of your data. 

Microsoft Access has the look and feel of other Microsoft Office products as far as its 

layout and navigational aspects are concerned, but MS Access is a database and, more 

specifically, a relational database. 

 Before MS Access 2007, the file extension was *.mdb, but in MS Access 2007 the 

extension has been changed to *.accdb extension. 

 Early versions of Access cannot read accdb extensions but MS Access 2007 and later 

versions can read and change earlier versions of Access. 

 An Access desktop database (.accdb or .mdb) is a fully functional RDBMS. 

 It provides all the data definition, data manipulation, and data control features that you 

need to manage large volumes of data. 

 You can use an Access desktop database (.accdb or .mdb) either as a standalone RDBMS 

on a single workstation or in a shared client/server mode across a network. 

 A desktop database can also act as the data source for data displayed on webpages on 

your company intranet. 

 When you build an application with an Access desktop database, Access is the RDBMS. 
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Data Definition 

Let us now understand what Data Definition is − 

 In document or a spreadsheet, you generally have complete freedom to define the 

contents of the document or each cell in the spreadsheet. 

 In a document, you can include paragraphs of text, a table, a chart, or multiple columns 

of data displayed with multiple fonts. 

 In spreadsheet, you can have text data at the top to define a column header for printing 

or display, and you might have various numeric formats within the same column, 

depending on the function of the row. 

 An RDBMS allows you to define the kind of data you have and how the data should be 

stored. 

 You can also usually define rules that the RDBMS can use to ensure the integrity of your 

data. 

 For example, a validation rule might ensure that the user can’t accidentally store 

alphabetic characters in a field that should contain a number. 

Data Manipulation 

Working with data in RDBMS is very different from working with data in a word processing 

or spreadsheet program. 

 In a word processing document, you can include tabular data and perform a limited set 

of functions on the data in the document. 

 You can also search for text strings in the original document and, with ActiveX controls, 

include tables, charts, or pictures from other applications. 

 In a spreadsheet, some cells contain functions that determine the result you want, and 

in other cells, you enter the data that provides the source information for the 

functions. 

An RDBMS provides you many ways to work with your data. For example, 

 You can search a single table for information or request a complex search across several 

related tables. 

 You can update a single field or many records with a single command. 

 You can write programs that use RDBMS commands to fetch data that you want to 

display and allow the user to update the data. 
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Access uses the powerful SQL database language to process data in your tables. Using SQL, 

you can define the set of information that you need to solve a particular problem, including 

data from perhaps many tables. 

Data Control 

Spreadsheets and word processing documents are great for solving single-user problems, 

but they are difficult to use when more than one person needs to share the data. 

 When you need to share your information with others, RDBMS gives you the flexibility 

to allow multiple users to read or update your data. 

 An RDBMS that is designed to allow data sharing also provides features to ensure that 

no two people can change the same data at the same time. 

 The best systems also allow you to group changes (which is also known as transaction) 

so that either all the changes or none of the changes appear in your data. 

 You might also want to be sure that no one else can view any part of the order until you 

have entered all of it. 

 Because you can share your Access data with other users, you might need to set some 

restrictions on what various users are allowed to see or update. 

Microsoft Access Objects 

MS Access uses “objects" to help the user list and organize information, as well as prepare 

specially designed reports. When you create a database, Access offers you Tables, Queries, 

Forms, Reports, Macros, and Modules. Databases in Access are composed of many objects but 

the following are the major objects − 

 Tables 

 Queries 

 Forms 

 Reports 

Together, these objects allow you to enter, store, analyze, and compile your data. Here is a 

summary of the major objects in an Access database; 

Tables 

Table is an object that is used to define and store data. When you create a new table, 

Access asks you to define fields which is also known as column headings. 

 Each field must have a unique name, and data type. 
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 Tables contain fields or columns that store different kinds of data, such as a name or an 

address, and records or rows that collect all the information about a particular instance 

of the subject, such as all the information about a customer or employee etc. 

 You can define a primary key, one or more fields that have a unique value for each 

record, and one or more indexes on each table to help retrieve your data more quickly. 

Query 

An object that provides a custom view of data from one or more tables. Queries are a way 

of searching for and compiling data from one or more tables. 

 Running a query is like asking a detailed question of your database. 

 When you build a query in Access, you are defining specific search conditions to find 

exactly the data you want. 

 In Access, you can use the graphical query by example facility or you can write 

Structured Query Language (SQL) statements to create your queries. 

 You can define queries to Select, Update, Insert, or Delete data. 

 You can also define queries that create new tables from data in one or more existing 

tables. 

Form 

Form is an object in a desktop database designed primarily for data input or display or for 

control of application execution. You use forms to customize the presentation of data that 

your application extracts from queries or tables. 

 Forms are used for entering, modifying, and viewing records. 

 The reason forms are used so often is that they are an easy way to guide people toward 

entering data correctly. 

 When you enter information into a form in Access, the data goes exactly where the 

database designer wants it to go in one or more related tables. 

Report 

Report is an object in desktop databases designed for formatting, calculating, printing, and 

summarizing selected data. 

 You can view a report on your screen before you print it. 

 If forms are for input purposes, then reports are for output. 
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 Anything you plan to print deserves a report, whether it is a list of names and 

addresses, a financial summary for a period, or a set of mailing labels. 

 Reports are useful because they allow you to present components of your database in 

an easy-to-read format. 

 You can even customize a report's appearance to make it visually appealing. 

 Access offers you the ability to create a report from any table or query. 

 

Getting Started with Microsoft Access 

In this section, we will discuss how to get started with Microsoft Access. We will 

understand how to start a Microsoft Access application in simple steps. Assuming you have 

Microsoft Excel installed in your PC, to start the application, follow these steps – 

Step 1: 

 

 

 

 

 

Click on the windows button 
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Step 2: 

 

Step 3: 

 

NB: I have installed Microsoft Access 2013 on my PC, the procedure will work on both later 

and earlier version of Microsoft Access. 

Click on the Search button 

Type Access in the search box and PRESS the ENTER button 

on your keyboard 
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Step 4: We have successfully opened Microsoft Access.  

 

 

Microsoft Access - Create Database 

You can search for database templates online but sometimes editing a database 

template to suit your requirement maybe hectic compare to creating a database from scratch. 

To create a Database in Microsoft Access, follow the steps below:  

Step 1: Start by opening Microsoft Access. 
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Step 2: Select Blank desktop database. Enter the name and click the Create button. 

 

Step 3: Access will create a new blank database and will open up the table which is also 

completely blank. 

 

 

Enter the name of the database Click on the Create button 
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Microsoft Access – Data Types 

Every field in a table has properties and these properties define the field's characteristics 

and behavior. The most important property for a field is its data type. A field's data type 

determines what kind of data it can store. MS Access supports different types of data, each 

with a specific purpose. 

 The data type determines the kind of the values that users can store in any given field. 

 Each field can store data consisting of only a single data type. 

Here are some of the most common data types you will find used in a typical Microsoft 

Access database. 

Type of Data Description Size 

Short Text 

Text or combinations of 

text and numbers, 

including numbers that do 

not require calculating 

(e.g. phone numbers). 

Up to 255 characters. 

Long Text 

Lengthy text or 

combinations of text and 

numbers. 

Up to 63, 999 characters. 

Number 
Numeric data used in 

mathematical calculations. 

1, 2, 4, or 8 bytes (16 bytes if set to Replication ID). 

Date/Time 

Date and time values for 

the years 100 through 

9999. 

8 bytes 

Currency 

Currency values and 

numeric data used in 

mathematical calculations 

involving data with one to 

four decimal places. 

8 bytes 
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AutoNumber 

A unique sequential 

(incremented by 1) 

number or random 

number assigned by 

Microsoft Access 

whenever a new record is 

added to a table. 

4 bytes (16 bytes if set to Replication ID). 

Yes/No 

Yes and No values and 

fields that contain only 

one of two values (Yes/No, 

True/False, or On/Off). 

1 bit. 

 

 If you use previous versions of Access, you will notice a difference for two of those data 

types. 

 In Access 2013, we now have two data types — short text and long text. In previous 

versions of Access these data types were called text and memo. 

 The text field is referred to as short text and your memo field is now called long text. 

Here are some of the other more specialized data types, you can choose from in Access. 

Data Types Description Size 

Attachment 

Files, such as digital photos. Multiple files can be 

attached per record. This data type is not available in 

earlier versions of Access. 

Up to about 2 GB. 

OLE objects 
OLE objects can store pictures, audio, video, or other 

BLOBs (Binary Large Objects) 

Up to about 2 GB. 

Hyperlink 

Text or combinations of text and numbers stored as 

text and used as a hyperlink address. 

Up to 8,192 (each part of a 

Hyperlink data type can 

contain up to 2048 

characters). 

Lookup Wizard 
The Lookup Wizard entry in the Data Type column in 

the Design view is not actually a data type. When you 

Dependent on the data 

type of the lookup field. 
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choose this entry, a wizard starts to help you define 

either a simple or complex lookup field. 

A simple lookup field uses the contents of another 

table or a value list to validate the contents of a single 

value per row. A complex lookup field allows you to 

store multiple values of the same data type in each 

row. 

Calculated 

You can create an expression that uses data from one 

or more fields. You can designate different result data 

types from the expression. 

You can create an 

expression that uses data 

from one or more fields. 

You can designate 

different result data types 

from the expression. 

 

These are all the different data types that you can choose from when creating fields in a 

Microsoft Access table. 

Microsoft Access – Create Tables 

When you create a database, you store your data in tables. Because other database 

objects depend so heavily on tables, you should always start your design of a database by 

creating all of its tables and then creating any other object. Before you create tables, carefully 

consider your requirements and determine all the tables that you need. 

Let us try and create the first table that will store the basic contact information 

concerning the employees in Team Piccolo as shown in the following table − 

Field Name Data Type 

EmployeelD AutoNumber 

FirstName Short Text 

LastName Short Text 
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Address Short Text 

City Short Text 

State Short Text 

Phone Short Text 

 

Step 1: Open the database we created earlier. 
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Step 2: Let us now go to the Field tab and you will see that it is also automatically created. The 

ID which is an AutoNumber field acts as our unique identifier and is the primary key for this 

table. The ID field has already been created and we now want to rename it to suit our 

conditions. This is an Employee table and this will be the unique identifier for our employees. 

Click on ID field. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 1: Click on the ID 

field 

Step 2: Click on the Name & Caption option 

Step 3: Change the name of the field to EmployeeID 
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Step 3: 

 

We now have our employee ID field with the caption Employee ID. This is automatically 

set to auto number so we don't really need to change the data type. 

Step 4: Let us now add the rest of the fields by clicking on click to add. 

 

Click on the OK button 

Step 1: click on the Click to Add 

Step 2: Click on the data type for your field. 

If you noticed in the employee table above, 

the second field is FirstName and has a data 

type of Short Text 
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Step 5: 

 

Step 6: Follow the procedures from step 4 to step 5 to create the rest of the fields. 

 

 

Type in FirstName in the Box 
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Step 7: After you have created all the fields, hold the CTRL + S button on your keyboard to save 

your table. 

 

Step 8: 

 

 

Step 1: Type in the name of the 

table 

Step 2: Click on the OK button 

We have renamed the table to EmployeeDetails 
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As we have already created one table using Datasheet View. We will now create 

another table using the Table Design View. We will be creating the following fields in this 

table. This table will store the employee login details. 

Field Name Data Type 

EmployeeID AutoNumber 

Password Short Text 

Status Short Text 

Category Short Text 

 

Step 1: 

 

 

 

Step 1: Click on the CREATE tab 

Step 2: Click on Table Design 
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Step 2: Create your fields as in the screenshot below: 

 

Step 3: Save the table by holding the CNTRL + S buttons on your keyboard. 

 

 

 

Step 1: Click on the EmployeeID to make it the primary 

key of the table 
Step2: Click on the Primary 

Key 

Step1: Enter the table name 

here 

Step 2: Click on the OK button 
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Microsoft Access - Adding Data 

An Access database is not a file in the same sense as a Microsoft Office Word document or 

a Microsoft Office PowerPoint are. Instead, an Access database is a collection of objects like 

tables, forms, reports, queries etc. that must work together for a database to function 

properly. We have now created two tables with all of the fields and field properties necessary 

in our database. To view, change, insert, or delete data in a table within Access, you can use 

the table’s Datasheet View. 

 A datasheet is a simple way to look at your data in rows and columns without any 

special formatting. 

 Whenever you create a new web table, Access automatically creates two views that you 

can start using immediately for data entry. 

 A table open in Datasheet View resembles an Excel worksheet, and you can type or 

paste data into one or more fields. 

 You do not need to explicitly save your data. Access commits your changes to the table 

when you move the cursor to a new field in the same row, or when you move the 

cursor to another row. 

 By default, the fields in an Access database are set to accept a specific type of data, 

such as text or numbers. You must enter the type of data that the field is set to accept. 

If you don't, Access displays an error message − 
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Let us add some data into the tables we have created. 

Step 1: 

 

Step 2: Add some data to your tables. 

 

 

Step 1: Click on the View 

button 

Step 2: Click on Datasheet View to add data to your table 
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Microsoft Access – Deleting Data 

If you want to delete any data you need to select the entire row first as shown in the 

following screenshot. 

Step 1: 

 

Step 2: Click on the DELETE button on your keyboard. 

 

 

The sixth row has been selected 

Click on the Yes button to confirm 

Click on the No button if you want to undo the action 



180 
www.teampiccolo.com 

Microsoft Access – Query Data 

A query is a request for data results, and for action on data. You can use a query to answer 

a simple question, to perform calculations, to combine data from different tables, or even to 

add, change, or delete table data. 

 As tables grow in size they can have hundreds of thousands of records, which makes it 

impossible for the user to pick out specific records from that table. 

 With a query you can apply a filter to the table's data, so that you only get the 

information that you want. 

 Queries that you use to retrieve data from a table or to make calculations are called 

select queries. 

 Queries that add, change, or delete data are called action queries. 

 You can also use a query to supply data for a form or report. 

 In a well-designed database, the data that you want to present by using a form or 

report is often located in several different tables. 

 The tricky part of queries is that you must understand how to construct one before you 

can actually use them. 

Create Select Query 

If you want to review data from only certain fields in a table, or review data from 

multiple tables simultaneously or maybe just see the database on certain criteria, you can use 

the Select query. Let us now look into a simple example in which we will create a simple query 

which will retrieve information from EmployeeDetails table. Open the database and click on 

the Create tab. 
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Step 1: 

 

Step 2: Double click on the EmployeeDetails table. 

 

 

 

Step 1: Click on the CREATE tab Step 2: Click on Query Design option 

Step 1: double click on the EmployeeDetails table 

Step 2: Click on the Close button 
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Step 3: Double click field you want to see as the result of the query. 

 

Step 4: 

 

 

 

Step 1: Double click on the field you 

want to see as the result of the query 

Step 2: each field you 

doubled click will appear 

here respectively 

Click on Run option on the DESIGN tab to run the query 
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Step 5:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The result of the query we run 
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Create an Update Query 

You can use an Update Query to change the data in your tables, and you can use an 

update query to enter criteria to specify which rows should be updated. An update query 

provides you an opportunity to review the updated data before you perform the update. Let us 

go to the Create tab again and click Query Design. 

Step 1: 

 

 

 

 

 

 

 

 

 

 

Step 1: double click on the EmployeeDetails table 

Step 2: Click on the Close button 
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Step 2: On the Design tab, in the Query Type group, click Update and double-click on the field 

in which you want to update the value. Let us say we want to update the FirstName of “Kabir” 

to “Sunusi”. 

 

Step 3: 

 

 

Step 1: Update to “Sunusi” 

Step 2: Enter the old value 

Click on Run to test the query 
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Step 4: 

 

Step 5: 

 

 

 

Click on Yes to confirm the query 

The FirstName field has been 

updated to “Sunusi” from “Kabir” 
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Create a Delete Query 

You can use a delete query to delete data from your tables, and you can use a delete 

query to enter criteria to specify which rows should be deleted. A Delete Query provides you an 

opportunity to review the rows that will be deleted before you perform the deletion. Let us go 

to the Create tab again and click Query Design. 

Step 1: 

 

 

 

 

 

 

 

 

 

 

 

Step 1: Double click on the 

EmployeeDetails table 

Step 2: Click on the Close button 
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Step 2: On the Design tab, in the Query Type group, click Delete and double-click on 

the EmployeeID. 

 

Step 3: In the Criteria row of the Design Grid, type 1. Here we want to delete an employee 

whose EmployeeID is 1. 

 

 

Step 1: Click on the Delete button 

Step 2: Double click on the EmployeeID 

Step 1: Type 1 inside the Criteria row 

Step 2: Click on Run 
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Step 4: 

 

Step 5: 

 

 

 

Click on the Yes button to confirm the query 

The Employee with EmployeeID 

has been deleted from the table 
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Microsoft Access – Normalization 

Database normalization, or simply normalization, is the process of organizing columns 

(attributes) and tables (relations) of a relational database to minimize data redundancy. It is 

the process of splitting data across multiple tables to improve overall performance, integrity 

and longevity. 

 Normalization is the process of organizing data in a database. 

 This includes creating tables and establishing relationships between those tables 

according to rules designed both to protect the data and to make the database more 

flexible by eliminating redundancy and inconsistent dependency. 

Let us now look into the following table which contains data, but the problem is that this 

data is quite redundant which increases the chances of typo and inconsistent phrasing during 

data entry. 

CustID Name Address Cookie Quantity Price Total 

1 Sunusi Yusuf No 1 Garko avenue off 

Lamido Crescent 

Chocolate 

Chip 

5 200.00 1000.00 

2 Goma Alfred 1234 Plateau Estate Jos Choc Chip 3 150.00 450.00 

3 Manusr Terrang 12 Main St., Adamawa 

Yola  

Chocolate 

Chip 

5 200.00 1000.00 

 

To solve this problem, we need to restructure our data and break it down into multiple tables 

to eliminate some of those redundancy as shown in the following three tables. 
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Here, we have one table for Customers, the 2nd one is for Orders and the 3rdone is for 

Cookies. 

The problem here is that just by splitting the data in multiple tables will not help to tell 

how data from one table relates to data in another table. To connect data in multiple tables, 

we have to add foreign keys to the Orders table. 

Defining Relationship 

A relationship works by matching data in key columns usually columns with the same 

name in both the tables. In most cases, the relationship matches the primary key from one 

table, which provides a unique identifier for each row, with an entry in the foreign key in the 

other table. There are three types of relationships between tables. The type of relationship 

that is created depends on how the related columns are defined. 

Let us now look into the three types of relationships − 

One-to-Many Relationship 

A one-to-many relationship is the most common type of relationship. In this type of 

relationship, a row in table A can have many matching rows in table B, but a row in table B can 

have only one matching row in table A. 

For example, the Customers and Orders tables have a one-to-many relationship: each 

customer can place many orders, but each order comes from only one customer. 

Many-to-Many Relationship 

In a many-to-many relationship, a row in table A can have many matching rows in table 

B, and vice versa. 

You create such a relationship by defining a third table, called a junction table, whose 

primary key consists of the foreign keys from both table A and table B. 

For example, the Customers table and the Cookies table have a many-to-many 

relationship that is defined by a one-to-many relationship from each of these tables to the 

Orders table. 

One-to-One Relationship 

In a one-to-one relationship, a row in table A can have no more than one matching row 

in table B, and vice versa. A one-to-one relationship is created if both the related columns are 

primary keys or have unique constraints. 

This type of relationship is not common because most information related in this way would 

be all in one table. You might use a one-to-one relationship to − 
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 Divide a table into many columns. 

 Isolate part of a table for security reasons. 

 Store data that is short-lived and could be easily deleted by simply deleting the table. 

 Store information that applies only to a subset of the main table. 

  

Microsoft Access – Creating Relationship 

One of the goals of good database design is to remove data redundancy. 

 To achieve that goal, you divide your data into many subject-based tables so that each 

fact is represented only once. 

 To do this, all the common fields which are related to each other are placed in one 

table. 

 To do this step correctly, you must first understand the relationship between your 

tables, and then specify these relationships in your Access database. 

MS Access uses table relationships to join tables when you need to use them in a database 

object. There are several reasons why you should create table relationships before you create 

other database objects, such as forms, queries, macros, and reports. 

 To work with records from more than one table, you often must create a query that 

joins the tables. 

 The query works by matching the values in the primary key field of the first table with a 

foreign key field in the second table. 

 When you design a form or report, MS Access uses the information it gathers from the 

table relationships you have already defined to present you with informed choices and 

to prepopulate property settings with appropriate default values. 

 When you design a database, you divide your information into tables, each of which has 

a primary key and then add foreign keys to related tables that reference those primary 

keys. 

 These foreign key-primary key pairings form the basis for table relationships and multi-

table queries. 
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Let us try to create a relationship between the EmployeeDetails table and 

EmployeeLoginDetails table. 

Step 1: 

 

Step 2: 

 

Step 1: Click on the DATABASE TOOLS tab Step 2: Click on the Relationships button 

Step 1: Select both the two tables 

Step 2: Click on the Add button 

Step 3: Click on the Close button 
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Step 3: 

 

Step 4: To create a relationship between these two tables, use the mouse, and click and hold 

the EmployeeID field from EmployeeDetails table and drag and drop that field on the field we 

want to relate by hovering the mouse right over EmployeeID from EmployeeLoginDetails. 

When you release your mouse button, Access will then open the following window − 
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Step 5: The above window relates EmployeeID of EmployeeDetails table to EmployeeID of 

EmployeeLoginDetails. Let us now click on the Create button and now these two tables are 

related. 

 

The relationship is now saved automatically and there's no real need to click on the Save 

button. Now that we have the most basic of relationships created, let us now go to the table 

side to see what has happened with this relationship. 
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Microsoft Access – Forms 

Forms in Access are like display cases in stores that make it easier to view or get the items 

that you want. Since forms are objects through which you or other users can add, edit, or 

display the data stored in your Access desktop database, the design of your form is an 

important aspect. There's a lot you can do design-wise with forms in Microsoft Access. You can 

create two basic types of forms − 

 Bound forms 

 Unbound forms 

Bound Forms 

Let us now understand what Bound Forms are − 

 Bound forms are connected to some underlying data source such as a table, query, or 

SQL statement. 

 Bound forms are what people typically think of when they think of the purpose of a 

form. 

 Forms are to be filled out or used to enter or edit data in a database. 

 Examples of bound forms will typically be what users use to enter, view or edit data in a 

database. 

Unbound Forms 

Let us look into Unbound Forms − 

 These forms are not connected to an underlying record or data source. 

 Unbound forms could be dialog boxes, switch boards, or navigation forms. 

 In other words, unbound forms are typically used to navigate or interact with the 

database at large, as opposed to the data itself. 

Types of Bound Forms 

There are many types of bound forms you can create in Access. Let us understand the 

types – 

 Single Item Form: This is the most popular one and this is where the records are 

displayed — one record at a time. 

 Multiple Item Form: This displays multiple records at a time from that bound 

data source. 
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 Split Form: The form is divided into halves, either vertically or horizontally. One 

half displays a single item or record, and the other half displays a list or provides 

a datasheet view of multiple records from the underlying data source. 

Creating Forms 

There are a few methods you can use to create forms in Access. For this, open your 

Database and go to the Create tab. In the Forms group, in the upper right-hand corner you will 

see the Form Wizard button. 

 

Click on that button to launch the Form Wizard. 

On this first screen in the wizard, you can select fields that you want to display on your 

form, and you can choose from fields from more than one table or a query. 

Let us assume we want to simply have a quick form that we are going to use for data 

entry for our employee information. 

 

 

 

 

 

Click on the Form Wizard 
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Step 1: From Tables/Queries drop-down list, select EmployeeDetails table. Click on the double 

arrow to move all the fields at once. 

 

Step 2: 

 

 

 

 

Click on the double arrow 

to move all the fields at 

once 

Click on the Next button 
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Step 3: The following screen in the Form Wizard will ask for the layout that we would like for 

our form. We have columnar, tabular, datasheet and justified layouts. We will choose the 

columnar layout here and then click the Next. 

 

Step 4: In the following screen, we need to give a title for our form. Let us call 

it EmployeeDetails. 

Once you have given your form a title, you can open the form to see what that form 

looks like, or you can begin entering information into your table. Or you can choose the option 

to modify the form's design. Let us choose the first option to open the form to view or enter 

information and click Finish. 

 

 

Click on the Next button 

Step 1: Enter the 

name of the form 

here 

Click on the Finish button 
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Step 5: Now, take a look at the following screenshot. This is what your form looks like. This is a 

single item form, meaning one record is displayed at a time and further down you can see the 

navigation buttons, which is telling us that this is displaying the record 1 of 4. If you click on that 

button then, it will move to the next record. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click on the Next button to 

view the next record 
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Microsoft Access – Data Import 

Normally data is stored in various formats, files, and locations, which makes it hard to get 

and use it. If you have data in a spreadsheet, a SharePoint list, or some other format, you can 

import it into an Access database with just a few steps, making it much more, easily available 

in Access. 

 The Save As command is generally used to save a document in another format, so that 

you can open it in another program. 

 In Access you can’t use the Save As command in the same way, you can save Access 

objects as other Access objects, but you cannot save an Access database as a 

spreadsheet file. 

 To save Access as a spreadsheet file, you will need to use the import feature on the 

External Data tab. 

Different Types of Data Access Can Import 

To understand what kind of data you can import in the Access data, let us open your 

database and go to the External Data tab. 

 

In the import & Link group, you can see the different kind of options available for data 

import in Access. Following are the most commonly used data import formats. 

 Microsoft Office Excel 
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 Microsoft Office Access 

 ODBC Databases (For example, SQL Server) 

 Text files (delimited or fixed-width) 

 XML Files 

To import the data in Access, we first need to open the Access database and then go to the 

External Data tab as in the following screenshot. 

Step 1: 

 

 

 

 

 

 

 

 

 

 

Step 1: Click on the EXTERNAL DATA 
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Step 2: Let try to import an Excel Spreadsheet 

 

Step 3: Browse the Excel file from which you want to import data and the then we have 

different options to store data. Let us select the first option and click Ok. 

 

 

Click on Excel option 

Step 2: Click OK button 

Step 1: Click on the 

Browser button to locate 

the file on your PC 



204 
www.teampiccolo.com 

Step 4: Here you will see the preview of your data. Now, click the Next. 

 

Step 5: In the Preview, you can now see that the first row contains the column headings. Let us 

now check the check box and click the Next. 

 

 

Click on the Next button 

Step 1: Check on the checkbox 

Step 2: Click on the Next button 
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Step 6: You will now see a dialog box where you can set the data type for each column/field. If 

you don’t want to import any field, just check the check box which says do not import field. 

Once you are done with the Employee field, just click on the January field, then the next field 

respectively. 

 

Step 7: Here are the different options for primary key. Let us select the first option and click the 

Next. 

 

 

Step 1: Select the Data Type of the field 

Step 2: Click on the Next button  

Click on the Next Button 
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Step 8: In the last dialog box, you can enter the table name of your choice and click Finish. 

 

Step 9: If you want to save all these steps, then check the checkbox and close the dialog box. 

 

 

 

Step 1: Type in the name of the table  

Step 2: Click on the Finish button 

Step 2: Click on the Close button 

Step 1: Check on the checkbox 



207 
www.teampiccolo.com 

Step 10: 

 

Step 11: 

 

 

 

Click on the table that you imported to view the data 

We have successfully imported the table from Excel Spreadsheet 
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Microsoft Access – Data Export 

Data export is actually the opposite of importing data. In importing data, we bring data 

from other formats in Access, while in exporting we save the data in other formats. 

To understand what kind of data you can export from Access data, let us open your 

database and go to the External Data tab. 

Step 1: 

 

Step 2: Let us try to export the EmployeeAllowance table to PDF 

 

Click on the PDF or XPS option 
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Step 3: Choose the location where you want to store the PDF file. 

 

 

Step 4: We have successfully exported the EmployeeAllowance table to PDF format 

 

 

Click on the Publish button 
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CorelDraw 
CorelDraw is one of the most popular and powerful graphics programs and gives 

designers a most rewarding and enjoyable work experience. It is built and designed to meet the 

day-to-day demands of working designers.  

CorelDraw software is available in the market and once loaded onto the computer, you 

can get started with your designing work. 

Getting Started with CorelDraw 

Step 1: 

 

 

 

 

 

 

 

 

 

Click on the Windows button 
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Step 2: 

 

Step 3: 

 

NB: I have installed CorelDraw X7 on my PC, the steps above will work for both earlier and 

later previous of CorelDRAW. 

 

Click on the Search button 

Type in CorelDraw in the search box 

and PRESS the ENTER button on your 

keyboard 
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Step 4: We have successfully started CorelDraw.  
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CorelDraw Window 

The various window components in CorelDraw are: 

 Title bar 

 Menu bar 

 Property bar 

 Tool bar (Standard) 

 Tool box 

 Rulers 

 Drawing Page 

 Drawing Window 

 Color Palette 

 Status bar 

 Document navigator 

 Navigator 

 

 

 

 

 

 

Title Bar Menu Bar Property Bar 
Tool Bar 

Tool Box 

Ruler 
Drawing Page 

Color Palette 

Navigator 

Document Navigator Status Bar 
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Designing a Book Cover 

In the section above, we explored the CorelDraw window. In this section we are going to 

design a book cover. 

In the steps below, we will be designing the book cover of this book: 
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Step 1: Open your CorelDraw application. 

 

Step 2: 

 

 

 

Click on the New Document option 

Double click on the Rectangle Tool 
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Step 3: 

 

Step 4: 

 

 

 

Click on the Cyan color 

in the Color Pallet 
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Step 5: 

 

Step 6: Drag the ruler from the LHS and place it on the LHS edge of your rectangle. 

 

 

Step 1: Drag the ruler 

Step 2: Place it on the node 

Step 1: Drag the ruler from 

here 

Step 2: Place it 

on the edge of 

the rectangle 
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Step 7: Repeat the same procedure by dragging the ruler from the LHS to the RHS of the edge 

of the rectangle. 

 

Step 8: Drag the ruler from the top and place it on the top of the rectangle. 
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Step 9: Repeat the same procedure by dragging the ruler from the top and place at the bottom 

of the rectangle. 

 

Step 10: Drag the ruler from the top and place it on the midpoint of the rectangle. 

 

 



221 
www.teampiccolo.com 

Step 11: Drag the ruler from the LHS and place it 0.5 inches on the rectangle. 

 

Step 12: Repeat same procedure and place it 8.0 inches on the rectangle. 

 

 

 

Enter 0.5 inside the 

object position box 

Enter 8.0 inside the 

object position box 
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Step 13: Create a new rectangle with size 3.0 by 0.3 inches 

 

Step 14: follow the same procedure above and create three (3) extra rectangles with sizes 4.0 

by 0.3 inches, 5.0 by 0.3 inches, and 6.0 by 0.3 inches respectively. 

 

  

Step 1: Click on 

the rectangle tool 

Step 2: Enter the 

rectangle width 

and height 
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Step 15: Drag the rectangles we created and place them on the main rectangle as in the 

screenshot below: 

 

Step 16: Click on the first rectangle and left click on the white color in the color palette. 

 

 

Step 1: Click on the rectangle 

Step 2: left click on the 

white color in the color 

palette 
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Step 17: follow the same procedure and apply the color to the rest of the rectangle as shown in 

the screenshot below: 

  

Step 18: we are through with the rectangles. Click on the Text Tool, we want to write the book 

title. Type INTRODUCTION TO COMPUTER APPLICATION 
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Step 19: Click on the pick tool and move the title of the book to the midpoint of the main 

rectangle as shown below in the screenshot below: 

 

Step 20: Change the font type and font size of the title. 

 

 

Step 1: Click on the Pick Tool 

Step 2: Move the title 

to the midpoint of the 

main rectangle 

Step 1: Select the title 

Step 2: Click on the Font 

list and select the font face 

“Calibri” 
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Step 21: Select the INTRODUCTION part of the title and increase the font size to 60px and font-

style to bold.  

 

Step 22: Select the TO COMPUTER APPLICATION part of the title; increase the font size to 45px 

and change the font-color to white. 

 

Step 1: Click on the font-size 

option and type 60  

Step 2: Click on the 

fold bold button 

Left click on the white color 
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Step 23: now bring the company logo into CorelDraw, drag the logo and drop it inside the 

CorelDraw window. 

  

Step 24: resize the logo by holding the SHIFT button on your keyboard.  
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Step 25: place the logo towards the RHS of the main rectangle below the title of the book. 

 

Step 26: Drag the ruler from the top and place it -10.5 inches from the bottom as shown below: 

 

 

Type -10.5 inside the object 

position box 
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Step 27: Click on the Text Tool and write “First Edition 2019”. Make the font face as “Aller”, 

font size as 16px and change the font color to white. Place it as in the screenshot below: 

 

Step 28: Click on the Text Tool and write “Author: Kabir Yusuf Bashir C.E.O 

www.teampiccolo.com”. Make the font face as “Aller”, font size as 16px and change the font 

color to white. Place it as in the screenshot below: 

 

Place it here 

Place it here 
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Step 29: We are almost through with the cover page design. Select the whole design as shown 

below. You can select the whole design by holding the left button on your mouse and dragging 

your mouse to cover the whole design.  

 

Step 30:  

 

NB: you can leave the border on your design but for the purpose of this design, we don’t need 

the borders. 

Right click on the button to 

remove the borders on the 

design 
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Step 31: We are done with the design, let us export the design to a JPEG format. Click on the 

file tab and select the Export option.  

 

Step 32: 

 

 

Click on the Export option 

Step 1: Enter the name of the file 

Step 2: Click on the Export button 
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Step 33:  

 

Step 34: Locate the file and try to view it. 

 

 

 

Click on the OK button 
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Chapter 4: The Internet 

What is an Internet? 

The internet is a globally connected network system that uses TCP/IP to transmit data 

via various types of media. The internet is a network of global exchanges – including private, 

public, business, academic and government networks – connected by guided, wireless and 

fiber-optic technologies. 

 

How to Create an Email 

What is an Email? 

An email address identifies an email box to which email messages are delivered. 

Example of an email address: kabir.yusuf@teampiccolo.com 

 To create an Email, you must have an Internet Connection. To connect to an Internet 

Connection, follow the steps below: 

Step 1: 

 

 

Click on the button 
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Step 2: 

 
 

 

Step 3: 

 

 

 

 

 

 

 

Click on the available network you want to 

use. I will click on Team Piccolo Global 

Enterprises 

Click on the Connect button 
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Step 4: 

 

 

 

Step 5: 

 

 

 

 

 

Enter the network password and 

click on the Next button 
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Step 6: 

 

You are connected to the Internet. Choose your favorite web browser. A web browser is 

a software application for accessing information on the World Wide Web. Examples of browser 

include Google Chrome, Mozilla Firefox, Safari, Internet Explorer, Opera etc. 

I will be using Google Chrome throughout this book. I will be explaining later on how to 

search and download on the Internet.   

Now open your Google Chrome web browser and follow the following steps below: 

Step 1: 

 

On your Address Bar, type www.google.com 

NB: www.google.com is a search engine website that you can use to search 

whatever you are looking on the internet. 

http://www.google.com/
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Step 2: 

 

 

Step 3: 

 

 

 

 

 

Type How to Create a Gmail Email Address in the search box 

Click on this link 
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Step 4: Fill in the required fields below and Click on the NEXT button. 

 

NB: Choose a password that you can easily remember. 

Step 5: 
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Step 6: Fill in the required fields and Click on the NEXT button 

 

 

Step 7: Click on the SEND button, a confirmation code will be sent to your Phone number you 

used in the screenshot above. 
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Step 8: Click on the VERIFY button to verify your account 

 

 

Step 9: Click on the button “YES, I’M IN” 
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Step 10: 

 

 

Step 11: Click on the NEXT button to start using your GMAIL account. 

 

 

Congratulations, you have successfully created your Gmail account.  

 

Scroll down and Click 

on the I AGREE button 
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Advanced research on the Internet 
Researching the Internet is quite an easy task. Most people search the internet for one 

or more reasons. Some maybe an assignment given to them in the school by their chemistry 

teacher to find about a particular element in the periodic table or by their computer teacher to 

find the list of computer schools on Lamido Crescent. 

The best way to search the Internet is to use a search engine. A Search engine is a 

service that allows Internet users to search for content via the World Wide Web (WWW). 

Examples of search engines:  

 Bing 

 DuckDuckGo 

 Wiki 

 CC Search 

 Gibiru 

 Search Encrypt 

 Yandex 

 StartPage 

 BoardReader 

 Ecosia 

 Google 

Google is the most known search engine and the best. I will be using Google throughout 

this book. 
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Let us try to find out on Google some “List of Computer Schools in Lamido Crescent 

Kano”. Open your browser and on your address bar type www.google.com 

 

 

Or you attended a lecture presentation by the C.E.O (Chief Executive Officer) of Team 

Piccolo Global Enterprises on Web Development and you decide to find out more about him. 

 

The result of our search  

http://www.google.com/
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System automation and its function to organizations 

What is System Automation? 

Automated system operations (ASO) is the set of software and hardware that allows 

computer systems, network devices or machines to function without any manual intervention. 

ASOs allow computer systems to work without a human operator physically located at the site 

where the system is installed. Automated system operations are a part of the automatic system 

control where the processes are completely automated with the help of control loops and 

special logic. 

Advantages and Disadvantages of System Automations to Organizations 

Advantages commonly attributed to automation include  

 Higher production rates and increased productivity,  

 More efficient use of materials,  

 Better product quality, 

 Improved safety  

Higher output and increased productivity have been two of the biggest reasons in 

justifying the use of automation. Despite the claims of high quality from good workmanship by 

humans, automated systems typically perform the manufacturing process with less variability 

than human workers, resulting in greater control and consistency of product quality. Also, 

increased process control makes more efficient use of materials, resulting in less scrap. 

A main disadvantage often associated with automation, worker displacement. Despite 

the social benefits that might result from retraining displaced workers for other jobs, in almost 

all cases the worker whose job has been taken over by a machine undergoes a period of 

emotional stress. In addition to displacement from work, the worker may be displaced 

geographically. In order to find other work, an individual may have to relocate, which is another 

source of stress. 

Other disadvantages of automated equipment include the high capital expenditure 

required to invest in automation (an automated system can cost millions of dollars to design, 

fabricate, and install), a higher level of maintenance needed than with a manually operated 

machine, and a generally lower degree of flexibility in terms of the possible products as 

compared with a manual system (even flexible automation is less flexible than humans, the 

most versatile machines of all). 

Also there are potential risks that automation technology will ultimately subjugate 

rather than serve humankind. The risks include the possibility that workers will become slaves 

to automated machines, that the privacy of humans will be invaded by vast computer data 
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networks, that human error in the management of technology will somehow endanger 

civilization, and that society will become dependent on automation for its economic well-being. 

These dangers aside, automation technology, if used wisely and effectively, can yield 

substantial opportunities for the future. There is an opportunity to relieve humans from 

repetitive, hazardous, and unpleasant labour in all forms. And there is an opportunity for future 

automation technologies to provide a growing social and economic environment in which 

humans can enjoy a higher standard of living and a better way of life. 
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CHAPTER 5 - Computer Diseases 

What is a Computer Virus? 
A computer virus, much like a flu virus, is designed to spread from host to host and has 

the ability to replicate itself. Similarly, in the same way that flu viruses cannot reproduce 

without a host cell, computer viruses cannot reproduce and spread without programming such 

as a file or document. 

In more technical terms, a computer virus is a type of malicious code or program 

written to alter the way a computer operates and is designed to spread from one computer to 

another. A virus operates by inserting or attaching itself to a legitimate program or document 

that supports macros in order to execute its code. In the process, a virus has the potential to 

cause unexpected or damaging effects, such as harming the system software by corrupting or 

destroying data. 

How does a computer virus attack? 

Once a virus has successfully attached to a program, file, or document, the virus will lie 

dormant until circumstances cause the computer or device to execute its code. In order for a 

virus to infect your computer, you have to run the infected program, which in turn causes the 

virus code to be executed. 

This means that a virus can remain dormant on your computer, without showing major 

signs or symptoms. However, once the virus infects your computer, the virus can infect other 

computers on the same network. Stealing passwords or data, logging keystrokes, corrupting 

files, spamming your email contacts, and even taking over your machine are just some of the 

devastating and irritating things a virus can do. 

While some viruses can be playful in intent and effect, others can have profound and 

damaging effects. This includes erasing data or causing permanent damage to your hard disk. 

Worse yet, some viruses are designed with financial gains in mind. 

 

How do computer viruses spread? 

In a constantly connected world, you can contract a computer virus in many ways, some 

more obvious than others. Viruses can be spread through email and text message attachments, 

Internet file downloads, and social media scam links. Your mobile devices and smartphones can 

become infected with mobile viruses through shady app downloads. Viruses can hide disguised 

as attachments of socially shareable content such as funny images, greeting cards, or audio and 

video files. 
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To avoid contact with a virus, it’s important to exercise caution when surfing the web, 

downloading files, and opening links or attachments. To help stay safe, never download text or 

email attachments that you’re not expecting, or files from websites you don’t trust. 

What are the signs of a computer virus? 

A computer virus attack can produce a variety of symptoms. Here are some of them: 

 Frequent pop-up windows. Pop-ups might encourage you to visit unusual sites. Or they 

might prod you to download antivirus or other software programs. 

 Changes to your homepage. Your usual homepage may change to another website, for 

instance. Plus, you may be unable to reset it. 

 Mass emails being sent from your email account. A criminal may take control of your 

account or send emails in your name from another infected computer. 

 Frequent crashes. A virus can inflict major damage on your hard drive. This may cause 

your device to freeze or crash. It may also prevent your device from coming back on. 

 Unusually slow computer performance. A sudden change of processing speed could 

signal that your computer has a virus. 

 Unknown programs that start up when you turn on your computer. You may become 

aware of the unfamiliar program when you start your computer. Or you might notice it 

by checking your computer’s list of active applications. 

 Unusual activities like password changes. This could prevent you from logging into your 

computer. 

 

What are the different types of computer viruses? 

Boot sector virus: This type of virus can take control when you start — or boot — your 

computer. One way it can spread is by plugging an infected USB drive into your computer. 
Web scripting virus: This type of virus exploits the code of web browsers and web pages. If 

you access such a web page, the virus can infect your computer. 

Browser hijacker: This type of virus “hijacks” certain web browser functions, and you may be 

automatically directed to an unintended website. 

Resident virus: This is a general term for any virus that inserts itself in a computer system’s 

memory. A resident virus can execute anytime when an operating system loads. 

Direct action virus: This type of virus comes into action when you execute a file containing a 

virus. Otherwise, it remains dormant. 

Polymorphic virus: A polymorphic virus changes its code each time an infected file is executed. 

It does this to evade antivirus programs. 
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File infector virus: This common virus inserts malicious code into executable files — files used 

to perform certain functions or operations on a system. 

Multipartite virus: This kind of virus infects and spreads in multiple ways. It can infect both 

program files and system sectors. 

Macro virus: Macro viruses are written in the same macro language used for software 

applications. Such viruses spread when you open an infected document, often through email 

attachments. 

 

Anti-Virus Software 
Anti-Virus software is a software utility that detects, prevents, and removes viruses, 

worms, and other malware from a computer.  

Most anti-virus programs include an auto-update feature that permits the program to 

download profiles of new viruses, enabling the system to check for new threats. Anti-virus 

programs are essential utilities for any computer but the choice of which one is very important. 

One Anti-Virus program might find a certain virus or worm while another cannot, or vice-versa. 

Anti-virus software is also known as an anti-virus program or a vaccine. Example of Anti-

Virus Software: 

 Norton 

 BullGuard 

 McAfee 

 Panda 

 Bitdenfender 

 Kaspersky 

 AVG 

 Avast 
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Prevention Against virus infection 

How can you help protect your devices against computer viruses? Here are some of the 

things you can do to help keep your computer safe. 

 Use a trusted antivirus product and keep it updated with the latest virus definitions. 

 Avoid clicking on any pop-up advertisements. 

 Always scan your email attachments before opening them. 

 Always scan the files that you download using file sharing programs 

 

 

 

 

 

 

 

 

 

 

 



252 
www.teampiccolo.com 

References 
1. https://us.norton.com/internetsecurity-malware-what-is-a-computer-virus.html  

2. https://www.techopedia.com/definition/5416/anti-virus-software  

3. https://www.top10antivirussoftware.com/?utm_source=google&kw=antivirus%20softw

are&c=115076096425&t=search&p=&m=p&adpos=1t1&dev=c&devmod=&mobval=0&n

etwork=g&campaignid=360902545&adgroupid=33344000832&targetid=kwd-

21997851&interest=&physical=9076671&feedid=&a=677&ts=rotw&topic=&fbrem=&gcl

id=CjwKCAjw7MzkBRAGEiwAkOXexCJSEFS2nT2Q7JVHZzE_tolsC_ni5tzyqUCP4Yj0Y0oI0Ex

rXDy7-hoCjh4QAvD_BwE   

 

https://us.norton.com/internetsecurity-malware-what-is-a-computer-virus.html
https://www.techopedia.com/definition/5416/anti-virus-software
https://www.top10antivirussoftware.com/?utm_source=google&kw=antivirus%20software&c=115076096425&t=search&p=&m=p&adpos=1t1&dev=c&devmod=&mobval=0&network=g&campaignid=360902545&adgroupid=33344000832&targetid=kwd-21997851&interest=&physical=9076671&feedid=&a=677&ts=rotw&topic=&fbrem=&gclid=CjwKCAjw7MzkBRAGEiwAkOXexCJSEFS2nT2Q7JVHZzE_tolsC_ni5tzyqUCP4Yj0Y0oI0ExrXDy7-hoCjh4QAvD_BwE
https://www.top10antivirussoftware.com/?utm_source=google&kw=antivirus%20software&c=115076096425&t=search&p=&m=p&adpos=1t1&dev=c&devmod=&mobval=0&network=g&campaignid=360902545&adgroupid=33344000832&targetid=kwd-21997851&interest=&physical=9076671&feedid=&a=677&ts=rotw&topic=&fbrem=&gclid=CjwKCAjw7MzkBRAGEiwAkOXexCJSEFS2nT2Q7JVHZzE_tolsC_ni5tzyqUCP4Yj0Y0oI0ExrXDy7-hoCjh4QAvD_BwE
https://www.top10antivirussoftware.com/?utm_source=google&kw=antivirus%20software&c=115076096425&t=search&p=&m=p&adpos=1t1&dev=c&devmod=&mobval=0&network=g&campaignid=360902545&adgroupid=33344000832&targetid=kwd-21997851&interest=&physical=9076671&feedid=&a=677&ts=rotw&topic=&fbrem=&gclid=CjwKCAjw7MzkBRAGEiwAkOXexCJSEFS2nT2Q7JVHZzE_tolsC_ni5tzyqUCP4Yj0Y0oI0ExrXDy7-hoCjh4QAvD_BwE
https://www.top10antivirussoftware.com/?utm_source=google&kw=antivirus%20software&c=115076096425&t=search&p=&m=p&adpos=1t1&dev=c&devmod=&mobval=0&network=g&campaignid=360902545&adgroupid=33344000832&targetid=kwd-21997851&interest=&physical=9076671&feedid=&a=677&ts=rotw&topic=&fbrem=&gclid=CjwKCAjw7MzkBRAGEiwAkOXexCJSEFS2nT2Q7JVHZzE_tolsC_ni5tzyqUCP4Yj0Y0oI0ExrXDy7-hoCjh4QAvD_BwE
https://www.top10antivirussoftware.com/?utm_source=google&kw=antivirus%20software&c=115076096425&t=search&p=&m=p&adpos=1t1&dev=c&devmod=&mobval=0&network=g&campaignid=360902545&adgroupid=33344000832&targetid=kwd-21997851&interest=&physical=9076671&feedid=&a=677&ts=rotw&topic=&fbrem=&gclid=CjwKCAjw7MzkBRAGEiwAkOXexCJSEFS2nT2Q7JVHZzE_tolsC_ni5tzyqUCP4Yj0Y0oI0ExrXDy7-hoCjh4QAvD_BwE
https://www.top10antivirussoftware.com/?utm_source=google&kw=antivirus%20software&c=115076096425&t=search&p=&m=p&adpos=1t1&dev=c&devmod=&mobval=0&network=g&campaignid=360902545&adgroupid=33344000832&targetid=kwd-21997851&interest=&physical=9076671&feedid=&a=677&ts=rotw&topic=&fbrem=&gclid=CjwKCAjw7MzkBRAGEiwAkOXexCJSEFS2nT2Q7JVHZzE_tolsC_ni5tzyqUCP4Yj0Y0oI0ExrXDy7-hoCjh4QAvD_BwE

